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Welcome to the WorkForce K301® User’s Guide.






Product Basics

See these sections to learn more about using your product:
Use the Control Panel
Identify Product Parts

Use the Control Panel

See these sections:

Raise and Lower the Control Panel
Use the Control Panel Buttons
Adjust the LCD Screen Brightness
Change the Control Panel Language

Raise and Lower the Control Panel

You can adjust the angle of the control panel. To raise it, lift it up from the bottom. To lower it,
press the release bar underneath.

To avoid damaging the printer, make sure you press the release bar to lower the control panel.
Don’t try to push it down without releasing it.

Use the Control Panel Buttons

Move the cursor

I and select menu
LCD screen A items
(o
A4 I Stop
power © (53
EREO) =Y
Turns product L )\ OK
on/off Select menu items
Menu Back to Start copying/scanning
Enters menu mode previous menu

Adjust the LCD Screen Brightness



You can adjust the brightness of the LCD screen.

To adjust the brightness:

© 0 A~ LD

Press the () power button.

Press the v= menu button.

Press A or ¥ to select Maintenance, then press OK.
Press A or ¥ to select LCD Contrast, then press OK.

Press A or ¥ to adjust the brightness of the screen, then press OK.

When you’re done, press the v= menu button again to exit.

Change the Control Panel Language

You can choose the language used on the LCD screen.

1.

o M W

Press the v= menu button.

Press A or ¥ to select Maintenance, and press OK.

Press A or ¥ to select Language, and press OK.

Press A or ¥ to select your language, and press OK.
When you’re done, press the v= menu button again to exit.

Identify Product Parts

Use these illustrations to identify the parts of your product.

Automatic Document Feeder
(ADF); cover closed

LCD screen

Control panel



Edge guides

ADF paper support

ADF output tray

Paper stopper

Qutput tray and extensions
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Load Paper

Before you copy or print, load paper for the type of printing you will do.
Load Paper for Documents

Load Envelopes
General Paper Information

Load Paper for Documents

You can print documents on a variety of paper types and sizes. If you are just making a copy or
printing a rough draft, plain paper is fine. However, for the best results, use one of Epson’s special
ink jet papers.

For automatic two-sided printing, use plain paper or Epson Bright White Paper.

If you’re using plain paper, you can load up to 250 sheets in the paper cassette; when using other
paper types, be sure to check the recommended number of sheets.

1. Pull out the paper cassette.

Note:
If you are using legal-size paper, extend the paper cassette by pushing the tab and pulling the
end of the cassette as shown below.

11



2. Slide the edge guides to the sides of the paper cassette.

Note:
Make sure the paper is not sticking out from the end of the cassette.

12
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Tip:

Fan the paper and align its edges before loading.

Load only the recommended number of sheets.

Load paper short edge first, no matter which way your document faces.

Load letterhead or pre-printed paper with the top edge facing the back of the paper cassette.
Do not load paper with holes punched in it.

Do not load transparencies.

Do not load paper above the X arrow marks on the edge guides.

Check the paper package for any additional loading instructions.

5. Slide the edge guides against the edges of the paper, but not too tightly. Make sure the paper is
under the tabs on the guides.

13



Note:

The paper may slide forward slightly as you insert the cassette. This is normal.
Keep the cassette flat as you insert it.

Do not remove or insert the cassette while printing or copying.

7. Pull out the output tray extensions, and flip up the paper stopper.

Note:
If you are using legal-size paper, do not raise the paper stopper.

See also:
Load Envelopes

Load Envelopes

You can print on plain paper envelopes in 4 1/8 x 9 1/2 inch (#10) (105 x 241 mm) size.
1. Pull out the paper cassette.

2. Slide the edge guides to the sides of the paper cassette.

14



Note:
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Tip:
Press each envelope flat before loading it or load one envelope at a time.

5. Slide the edge guides against the edges of the envelopes, but not too tightly. Make sure the
envelopes are under the tabs on the guides.

Note:

The envelopes may slide forward slightly as you insert the cassette. This is normal.
Keep the cassette flat as you insert it.

Do not remove or insert the cassette while printing or copying.

7. Pull out the output tray extensions, and flip up the paper stopper.

16



Note:

Do not use envelopes that are curled or folded, and avoid using envelopes that are too thin
because they may curl during printing. Before printing from your computer, select Envelope as
the paper type, Envelope #10 as the paper size, and Landscape as the orientation. If you are
printing on envelopes of a different size, create a custom size in Windows, Mac OS X 10.5x to
10.6, and Mac OS X 10.4.

See also:

Load Paper for Documents

General Paper Information
Paper Cassette Capacity

Available Epson Papers
Double-Sided Printing
Paper or Media Type Settings for Loaded Paper

Paper Cassette Capacity

Paper type Load up to this many sheets

Plain paper—letter-size (8.5 x 11 inches [216 x 279 mm]) | Approximately 250 sheets™ ™

Epson Bright White Paper 200 sheets™

Epson Presentation Paper Matte 80 sheets

Plain paper—Iegal size (8.5 x 14 inches [216 x 356 mm]) | 30 sheets

Epson Premium Presentation Paper Matte 20 sheets

* Based on 20-1b [75 g/m?] paper weight. Do not load paper higher than the = arrow marks on the
edge guides. For User Defined paper sizes, load one sheet at a time.

** For manual two-sided printing, load up to 30 sheets.

Available Epson Papers



You can purchase genuine Epson ink and paper from your nearest authorized Epson dealer.

Contact Epson to locate the nearest one.

[216 x 279 mm])

; Sheet
Paper type Size Part number count
Epson Presentation Paper Matte Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
Epson Premium Presentation Paper Matte | Borderless 8 x 10 inches | S041467 50
(203 x 254 mm)
Letter (8.5 x 11 inches S041257 50
[216 x 279 mm]) S042180 100
Epson Bright White Paper Letter (8.5 x 11 inches S041586 500

Note:

Availability of paper types varies by country.

Double-Sided Printing

You can use the built-in duplexer to automatically print double-sided on plain paper or Epson
Bright White Paper. Double-sided printing is available from Windows, Mac OS X 10.5 and 10.6,

and Mac OS X 10.4.

Paper or Media Type Settings for Loaded Paper

For optimal image quality, it is important to choose the correct Type or Media Type setting in
your software. It tells your product what kind of paper you’re using and adjusts the ink coverage

accordingly.

For this paper

setting

Select this paper Type or Media Type

Plain paper
Epson Bright White Paper
Epson Presentation Paper Matte

Plain Paper

Epson Premium Presentation Paper Matte

Premium Presentation Paper Matte

Envelopes

Envelope

18




Place Originals for Copying or Scanning

Before you copy or scan, place your documents on the scanner.
Place Documents in the Automatic Document Feeder

Place Documents on the Scanner Glass

Place Photos on the Scanner Glass

Place Documents in the Automatic Document Feeder

You can copy or scan using the Automatic Document Feeder (ADF). You can load up to 30 letter-
or A4-size sheets, or 10 legal-size sheets (single-sided only). When loading legal-size sheets,
insert only 10 sheets at a time to prevent paper feeding problems. Make sure the originals are not
creased or folded and do not have tape, staples, or other materials that could obstruct the feeder.
Make sure there are no documents on the scanner glass.

Note:
If you copy a document larger than A4, the image will be cropped.

1. Open the ADF (Auto Document Feeder) paper support.

2. Fan the originals, then tap the stack on a flat surface to even the edges.

L

3. Move the edge guide outward.

19






Once the original document is loaded, you can copy or scan in black-and-white.
See also:
Place Documents on the Scanner Glass

Place Photos on the Scanner Glass

Place Documents on the Scanner Glass

You can place documents up to letter- or A4-size on the scanner glass and then copy or scan them.
Before you start, make sure the glass is clean.

Note:
You can also copy or scan a book or other thick document up to about 1/2 inch (12 mm) thick.

1. Open the scanner cover.

2. Place your original document face-down on the scanner glass with the top against the back left
corner.

3. Close the scanner cover gently to keep your document in place.
Once you’ve placed your original document, you can copy or scan it in black-and-white.

Note:
When there is a document on the scanner glass and in the Automatic Document Feeder, the
document in the ADF will be scanned.

See also:
Place Documents in the Automatic Document Feeder

Place Photos on the Scanner Glass

Place Photos on the Scanner Glass
You can place photos on the scanner glass and then copy or scan them.
1. Open the scanner cover.

2. Place your original photo face-down on the scanner glass with the top against the back left
corner.

21



Note:

If the edges of your photo are cut off, move the photo 1/4 inch (5 mm) away from the corner
of the scanner glass. For multiple photos, place them as shown below and at least 1/4 inch
(5 mm) apart.

&r 1 1 [ ’ﬁi{
_______________ _\_y 1/4 inch (5 mm)
A
. IZIZIZIZIZIZIZII\? 1/4 inch (5 mm)
A
S>Ti€
1/4 inch (5 mm)

3. Close the scanner cover gently to keep your photo in place.

Once you’ve placed your photo, you can copy or scan it in black-and-white.
See also:
Place Documents on the Scanner Glass

Place Documents in the Automatic Document Feeder

22



Copy Documents and Photos

You can use your product to copy documents and photos in black-and-white.
Copy Documents

Copy Photos

Note:
Copies may not be exactly the same size as your original document.

Copy Documents

You can copy documents in black-and-white onto letter, legal, or A4-size plain paper, Epson
Bright White Paper, or Epson Presentation Paper Matte, just like you would on a copy machine. If
you use the Automatic Document Feeder, you can copy up to 30 sheets at a time onto letter, legal,
or A4-size plain paper.

Note:

When originals are loaded in the Automatic Document Feeder, print settings are automatically set
to the following: Paper Size is set to Letter, Paper Type is set to Plain, and Reduce/Enlarge is set
to Actual Size. You can change the paper size to A4, if necessary. If you make copies larger than
letter or A4, the image will be cropped.

To copy a legal-size original onto letter paper using the Automatic Document, set the paper size to
Legal, and then set the Reduce/Enlarge option to Legal > Letter.

1. Load letter-, legal-, or A4-size plain paper or Epson special paper in the paper cassette.

Note:
Load only the recommended number of sheets.
Make sure you select the appropriate paper type.

Place your original document(s) on the scanner glass or in the Automatic Document Feeder.

Press the < start button to begin copying.

Copy Copies @ § 1
1 =+1-5ided with Bor

4. To print more than 1 copy, press A or ¥ to select the number (up to 99).

5. To change any of the print settings displayed on the screen, press = menu, press A or V¥ to
select an option, then press OK to change the setting.

Copy Mode Print Settings

23



To print double-sided, select 2-Sided Copying and choose the desired option. To change
the paper type, select Paper Type and choose the type of paper you loaded.

Paper type Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper
Epson Presentation Paper Matte

Epson Premium Presentation Paper Matte Matte

To change the paper size, select Paper Size and choose the size of paper you loaded.

To change the layout, select Layout and choose With Border to leave a small margin
around the image, or 2-up Copy to copy two pages onto a single sheet.

To adjust the copy size, select Reduce/Enlarge and choose either Actual, Auto Fit Page
(to automatically size the image to fit your paper), or Custom (to select a percentage using
A or ¥, or enter it on the numeric keypad).

Note:
If you placed legal-size originals in the Auto Document Feeder, select Legal>Letter to
copy a legal-size document on letter-size paper.

If you choose Plain Paper as your Paper Type setting, you can change the copy quality.
Select Quality and choose Standard Quality, Best, or Draft.

To adjust the darkness or lightness of the copy, select Copy Density and choose a higher
(darker) or lower (lighter) setting.

To change the drying time, select Dry Time and choose Standard, Longer, or Longest.

After you finish selecting your settings, press v= menu.

[DROP DOWN END]
6. Press the < start button to begin copying.
To cancel copying, press @ stop.

See also:
Copy Photos

Copy Photos

You can copy photos in black-and-white onto plain paper, Epson Bright White, or Epson Premium
Presentation Paper Matte, just like you would on a copy machine.

1.
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Load plain paper or Epson special paper in the paper cassette.

Note:
Load only the recommended number of sheets.

Place your original photo on the scanner glass.

Press the < start button to begin copying your photo.



Copy

1 —=+1-5ided with Bor

Copies : § 1

4. To print more than 1 copy, press A or ¥ to select the number (up to 99).

5. To change any of the print settings displayed on the screen, press = menu, press A or ¥ to
select an option, then press OK to change the setting.

[DROP

Copy Mode Print Settings

To print double-sided, select 2-Sided Copying and choose the desired option. To change
the paper type, select Paper Type and choose the type of paper you loaded.

Paper type Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper
Epson Presentation Paper Matte

Epson Premium Presentation Paper Matte Matte

To change the paper size, select Paper Size and choose the size of paper you loaded.

To change the layout, select Layout and choose With Border to leave a small margin
around the image, or 2-up Copy to copy two pages onto a single sheet.

To adjust the copy size, select Reduce/Enlarge and choose either Actual, Auto Fit Page
(to automatically size the image to fit your paper), or Custom (to select a percentage using
A or v, or enter it on the numeric keypad).

Note:
If you placed legal-size originals in the Auto Document Feeder, select Legal>Letter to
copy a legal-size document on letter-size paper.

If you choose Plain Paper as your Paper Type setting, you can change the copy quality.
Select Quality and choose Standard Quality, Best, or Draft.

To adjust the darkness or lightness of the copy, select Copy Density and choose a higher
(darker) or lower (lighter) setting.

To change the drying time, select Dry Time and choose Standard, Longer, or Longest.
DOWN END]

6. After you finish selecting your settings, press v= menu.

7. Press the < start button to begin copying.

To cancel copying, press @ stop.
See also:

Copy Documents
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Print From Your Computer

After you connect your product to your computer and install its software, you can print documents
from your computer.

Follow the instructions in these sections for your operating system:

Windows Printing

Mac Printing (Mac OS X 10.5 and 10.6)

Mac Printing (Mac OS X 10.4)

Before you print, make sure you installed your software and connected your product to your
computer or network; see the Start Here sheet for instructions.

Tip:

It’s a good idea to check for updates to your product software. See Checking for Software Updates
for instructions.

Also be sure to load paper in the paper cassette.

Windows Printing

You can print on your product using any Windows® printing program.
Follow the steps in these sections:

Print From a Program

Select Basic Options

Select Additional Printing Options
Select 2-Sided Printing Options
Print Your Document

Check Printing Status

Change Default Print Settings

Change the Language

See also:
Mac Printing (Mac OS X 10.5 and 10.6)
Mac Printing (Mac OS X 10.4)

Print From a Program

After you open a document in a Windows program, follow these steps to access your print
settings:

1. Select the print option in your application.

27
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Select the name of your Epson product.
Click Preferences or Properties.

Note:

If you don’t have these buttons, click Setup, Printer, or Options, then click Properties or
Preferences on the next screen.

Your printer settings window opens:

1 Prining Preferencet = |
Pristing Prescts Dot Size  [Lether (B 425 f1R) =]
5 Dovument - Fest Crieniaten # Foriran Landscape
jm: aasay foper Type | Plain Paper Dnght Whie Pager =
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Follow the steps in these sections to select settings, print, and control printing:
Select Basic Options
Select Additional Printing Options
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Print Your Document
Check Printing Status
Change Default Print Settings

Select Basic Options
There are two ways to select basic printing options:

» Select a printing preset to quickly select settings for common paper types, sizes, and print
qualities.

» Select individual settings on the Main tab.

Select a Printing Preset

For quick access to the most common settings, point to one of the Printing Presets on the Main or
More Options tab to view a list of the settings for it.

1 Piinting Dusfarences =
Han | Mo Options | Manberarce

Prisling Preschs Degurmenl Fipg Letber [B 42 % §1im)
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If the settings are correct for your print job, click the preset and print.

To create your own presets, click Add/Remove Presets, type a name for your new preset, then
click Save.

To delete a preset you created, click Add/Remove Presets, select the preset, and click Delete.
To reorder the list, highlight one of the Printing Presets and click the up or down arrow to move it.
Or click Reset Order to return the list to its original order.

Select Basic Settings on the Main Tab

Click the Main tab on the top of the printer settings window to select your basic print options.
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Tip:

For information about an option, move the mouse over the setting or right-click it to access the

on-screen Help.

1. Select the Document Size setting for the paper you loaded. A User Defined option is also
available so you can create a custom size.

2. Choose Portrait or Landscape orientation for your document. (Choose Landscape for
printing envelopes.)

o 0 &~ w

Select the Paper Type setting that matches the paper you loaded.
Select a Quality option that matches your document, and the print quality you want.

Select 2-sided Printing, if desired (see Select 2-Sided Printing Options for details).

Select Quiet Mode for quieter printing when Plain Paper/Bright White Paper is selected as
the Paper Type.

Select a Multi-Page option to print multiple pages onto one sheet.

You can also:

e Select more printing options.

» Select select 2-sided printing options.

» See asummary of your settings (click Show Settings).

» Return to the default settings (click Reset Defaults).

When you’re finished, you’re ready to print.

Select Additional Printing Options

You can select size, color, and more options on the More Options tab.
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For information on selecting settings, move the mouse over the setting or right-click the setting

and click Help.
See also:
Select Basic Options

Select 2-Sided Printing Options

Select 2-Sided Printing Options

You can select a variety of 2-sided Printing Options on the Main tab.

Note:

Make sure you use a paper type that is compatible with the duplexer.
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Select 2-Sided Printing, then select from the following options:
» Click Settings to customize binding settings used during double-sided printing.
2-Sided printing settings

* Binding Edge and Binding Margin: customizes the binding settings used during double-
sided printing.

» Create Folded Booklet: organizes double-sided printing page order to create a folded
booklet.

[DROP DOWN END]
See also:
Select Basic Options

Select Additional Printing Options

Print Your Document
After selecting your print settings, click OK to save them and return to the Print window.
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Click OK or Print to start printing.
During printing, you can check printing status by accessing the Windows Spooler.

Check Printing Status
During printing, you see this window showing the status of your print job. It allows you to control
printing.

=7 EPSON K300 Series = EH ==
Printer Document  View
Document Name Status Owner Pages Size Sut
Document Printing Mary 3/3 376 MB/3.BL .. B0
] 1 b

1 decument(s) in queue

» To cancel printing, right-click on the print job and click Cancel.

» To pause printing, click on the print job(s) you would like to pause, click Pause.

» To restart printing, click on the print job(s) that are marked “On hold” and click Restart.
If you see an error during printing, see Solve Problems for solutions.

Note:
You can also cancel printing by pressing your product’s @ stop button.

Change Default Print Settings
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When you change your print settings from within a program, the changes apply only while you’re
printing at that time. If you want to select different settings to use in all your Windows programs,
you can change the default print settings.

1. Right-click the % printer icon in the taskbar, usually in the bottom right corner of your screen.
2. Select Printer Settings. You see the Properties window:

= [PSON K300 Series Properies =
Man | pors Options | Maintsnarce

Prisling Prescls Decurmenil Sint Latber (B 43 = E1m)
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK to close the window.
You can still change the default settings from within a program as needed.

Change the Language

In Windows, you can choose English, Spanish or Portuguese as the language of the printer
software screens.

1. Right-click the % printer icon in the taskbar, usually in the bottom right corner of your screen,
and select Printer Settings.

2. Click the Maintenance tab.
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3. Select the Language you want to display.

4. Click OK to close the driver screen. The language used on the driver screen changes to your

selection the next time you access it.

Mac Printing (Mac OS X 10.5 and 10.6)

You can print using any Mac 0s® X printing program.
Follow the steps in these sections to print from your Mac®:

Open Your File for Printing

Select Basic Print Options

Select Page Setup Options

Change Print Layout

Print Double-sided

Print Your Document

Check Printing Status
General Printing Preferences

See also:
Windows Printing
Mac Printing (Mac OS X 10.4)

Open Your File for Printing
You can open a file for printing by either:
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» Starting a printing program and opening a document from it.
» Double-clicking a document file icon on the screen.
When you’re ready to print, select print options and then print.

Select Basic Print Options
After opening your file for printing, open the Print window to select your print options.

1. Open the File menu and select Print.
2. Select the name of your Epson product as the Printer setting.

Printer: | EPSON K300

10

=
-
:

F

@ K PDF v ._,I | Preview | [ Cancel )

Presets: | Standard

3. Click the w button to expand the Print window, if necessary.

Printer: | EPSON K300 i =]
Pregets; | Standard T‘
Copies: 1 ™ Collated
Pages: =) Al
i From: 1 w1
Paper Size: | US Letter 2 2.50 by 11.00 inches

Cirientation ' i l' -

Prewies T1

™ Aute Rotate

() Seale:

E’ Seale o Fin: H Print Entire Image
) Fill Entira Paper

Images per page: | 1 =
— Print 1 coples per page

i i b
. Cancel | [ Print

4. Select the page setup options. Choose the Paper Size and Orientation settings.

Note:
If you don’t see these settings here, check for them in your application before printing. For
example, you may be able to select them by opening the File menu and selecting Page Setup.

5. Select any settings that are specific to the application you’re using. For example, if you’re
printing from Preview, you see the application settings shown above.
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Select Print Settings from the pop-up menu.

Primter: | EPSON E300 a B
Presets: | Standard ﬂ
Copies: | 1 - Callated
Pages.: @ All
O From: |1 w1

Paper Size: | US Letter ﬁ 850 by 11.00 inches
Orientation: Ii ] -

Preview

A Auto Rota|  Lavout
Color Matching

() Scale: Paper Handling
Cover Page

(=) Scale to Fi Scheduler

Ourpur Sertings
Images pe

Supply Levals
— Print 1 4 Summary

I 1
[ Cancel [ Print )

These settings appear on the screen:

Printer: | EPSON K300 =+ =]
Pragets: LShndard a
Copies: 1 ol Collated
Pages: BNI

(O From: 1 w1

Paper Size | LIS Letter -ﬁ & 50 by 11,00 imches
Orientation: li l -

: Print Settings a

Media Type: | Plain Paper / Bright White Paper 15
Print Quality: | Normal 3

¥ Adwvanced Semings:

Bightogiy || | S——(e—
e e Comrast 0 | T

-

7. Select the Media Type setting that matches the paper you loaded.




8. Select a Print Quality for your document. Available settings depend on the selected Media
Type setting.

You can also:

» Select page setup options

» Select different print layout settings

* Print double-sided

When you’re finished, you’re ready to print.

Select Page Setup Options

Depending on your application, you may be able to select the paper size and orientation settings,
and adjust the size of your printed document, from the Print window.

Paper Size: | US Letter w5 ] 8.50 by 11.00 inches

Orientation: I_l ]i

Note:

If you don’t see these settings in the Print window, check for them in your application before
printing. For example, you may be able to select them by opening the File menu and selecting
Page Setup.

1. Select the Paper Size setting for the paper you loaded. A custom option is also available so
you can create a custom paper size.

2. Choose a portrait or landscape Orientation option for your document. (Choose '= | landscape
left for envelopes.)

You can also:
e Select basic print options

» Select different print layout settings
* Print double-sided
When you’re finished, you’re ready to print.

Change Print Layout
Select Layout from the pop-up menu to select a variety of layout options.

Note:
To print double-sided, see Print Double-Sided.

1. Select Layout in the pop-up menu.
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Layout 2

Pages per Sheet: | 1 =
ra S LA i~
Border: | Mone e

_! Rewerse page orlentatien
Flip harizantally

2. Select from the following options, as necessary:

To print multiple pages on one sheet, select 2, 4, 6, 9, or 16 in the Pages per Sheet pop-up
menu.

Select the order in which the multiple pages print on the sheet as the Layout Direction
setting.

To print borders around each page, select one of the line settings in the Border pop-up menu.

You can also flip the direction of your image by selecting Reverse page orientation or Flip
horizontally.

You can also:
» Select basic print options

» Select page setup options
e Print double-sided
When you’re finished, you’re ready to print.

Print Double-sided
With the built-in duplexer, you can print on both sides of the page automatically.

Note:
Make sure you use a paper type that is compatible with the duplexer.

Manual 2-sided printing is not supported in Mac OS X 10.5 to 10.
1. Select Output Settings from the pop-up menu.

Output Settings T1
Two-sided Printing Long-Edge binding - ]
Document Type: | Text T‘
Adjustmens
When printing a photo o document containing a lot of solkd image
areas. reduce the densiky of the ik and increase it drying bme.

2. Select a binding option for the Two-sided Printing setting.
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Select the type of document you’re printing.
Click » Adjustments to view more options.

5. Adjust the print density and drying time to prevent ink from bleeding through the page when
you print on plain paper.

You can also:
* Select basic print options

» Select page setup options

» Select different print layout settings

When you’re finished, you’re ready to print.

Print Your Document
After selecting your print settings, click Print to start printing.

During printing, you can check printing status.

Check Printing Status
During printing, you can view the progress of your print job and control printing.
1. Click your product icon when it appears in the Dock.

Bmm = EPSCIM K300 (1 jab)
Lt P

o 0 w - H -

Duiwie  mald  jul nfe Pause Frinier. Supely Levein  Froisl Wiup Frimter | dcsmnne
Printing "macl.”
, : Page 1 of 1

Hatul Hame Bent Lompheled

O Praites reas | 17 16 M

2. Select from these options:
» To cancel printing, click the print job and click Delete.

» To pause printing for a specific print job, click the print job and click Hold. To resume
printing, click the print job marked “Hold” and click Resume.

» To pause printing for all print jobs, click Pause Printer.
» To check ink status, click Supply Levels.
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Note:
You can also cancel printing by pressing your product’s & stop button.

3. When you’re finished, close the window to exit the program.
If you see an error during printing, see Solve Problems for solutions.

General Printing Preferences

You can select various printing preferences that will apply to all print jobs.

1. Open System Preferences, and then open the Print & Fax utility.

2. Make sure your printer is selected, then click the Options & Supplies button.
3. Click the Driver tab. You see this screen:

[ General | Driver Supply Levels = Utility |

Print Using: [ EPSON K300 FH

To take full advantage of your printer's options, confirm that they are accurately shown
here. For information on your printer and its optional hardware, check the printer's
documentation.

Skip Blank Page: [ Off B
Quiet Mode: [_Off H
Permit temporary one cartridge printing: | Off H

High Speed Printing: |_ On =

C—
| Cancel )

4. Select the following options:
» Skip Blank Page to ensure that pages without text or images are not printed

* Quiet Mode for quieter printing when Plain Paper/Bright White Paper is selected as the
Media Type

* Permit temporary one cartridge printing to print temporarily when one of the ink
cartridges is expended.

» High Speed Printing for faster printing; print quality is reduced.
5. Click OK when done.

Mac Printing (Mac OS X 10.4)

You can print using any Mac OS X printing program.
Follow the steps in these sections to print from your Mac:
Open Your File for Printing
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Select Page Options

Select Basic Print Options

Change Print Layout
Print Double-Sided
Print Your Document
Check Printing Status
See also:

Windows Printing
Mac Printing (Mac OS X 10.5 and 10.6)

Open Your File for Printing

You can open a file for printing by either:

» Starting a printing program and opening a document from it.
» Double-clicking a document file icon on the screen.

Note:
Before printing, make sure you added your printer to the Printer Setup Utility.

When you’re ready to print, select the page options and print options, and then print.

Select Page Options
Open the Page Setup window to select your page options.
1. Open the File menu and select Page Setup.

Settings: | Page Attributes B!

Format for: | K300 = ]

EPSOMN K300

Paper Size: | US Letter = ]

8.50 in x 11.00 in

Orientation: Iil ES 1€

Scale: |

(v
2/

Select the name of your Epson product as the Format for setting.

Select the Paper Size setting for the paper you loaded. A custom option is also available so
you can create a custom size.

4. Choose a portrait or landscape Orientation option for your document. (Choose '= landscape
left for envelopes.)
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5. Click OK to close the Page Setup window.
Now you can select your print settings and print.

Select Basic Print Options
After selecting your page options, open the Print window to select your print options.
1. Open the File menu and select Print.

(Prlntrr K300 _ﬂ )
Presets | Standard =T
Copies & Pages _:‘;l
Conies l- H Collated
Pages: Al
I From: |1 to: |1
(@) (_poFw ) ( Preview ) ( Supplies... ) (Cancel ) (Ehrints)

Select the name of your Epson product as the Printer setting.
Select Print Settings from the pop-up menu.

Note:
In certain programs, you may need to select Advanced before you can select Print Settings.

Printer; | K300 [ |
Presets: | Standard _:'
Print Sertings
Media Type: Plain Paper / Bright White Paper _:{
Primt Quality: | Normal _H

b Advanced Sertings:

(- POFw | [ Preview | [ Supplies: ) [ Standard | Cancel _lw

Select the Media Type setting that matches the paper you loaded.

Select a Print Quality for your document. Available settings depend on the selected Media
Type setting.

You can also:
» Select different print layout settings
e Print double-sided
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When you’re finished, you’re ready to print.

Change Print Layout

Select Layout from the pop-up menu to select a variety of layout options.

Note:
To print double-sided, see Print Double-Sided.

Printer: | K300

]
Presets:  Standard =
Layout [EY]

Pages per Sheet | 1 _:l

Layout Direction |E] S| N

1 Border.  Moane _:"

PI}E » Preview | Supplirs ] Standard Cancel | t—-ﬂlﬂh—}

You can also:

» Select basic print settings

e Print Double-Sided

When you’re finished, you’re ready to print.

Print Double-Sided

With the built-in duplexer, you can print on both sides of the page automatically.

Note:
Make sure you use a paper type that is compatible with the duplexer.

Manual 2-sided printing is not supported in Mac OS X 10.4.
1. Select Output Settings from the pop-up menu.
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Printer: | K300 [ |

Presets: | Standard =

Cutput Setrings [T
Two=sided Printing: | Off |

— Face Down Printing

P}Ew | .Frl.'wrw_ Supplies ] Standard Cancel | f- Prini }

Select a binding option for the Two-sided Printing setting.
Select the type of document you’re printing.
Click » Adjustments to view more options.

o M W

Adjust the print density and drying time to prevent ink from bleeding through the page when
you print on plain paper.

You can also:
e Select basic print settings

« Select different print layout settings

When you’re finished, you’re ready to print.

Print Your Document
After selecting your print settings, click Print to start printing.

During printing, you can check printing status.

Check Printing Status
During printing, you can view the progress of your print job and control printing.
1. Click your product icon when it appears in the Dock.
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806 K300

g w

i Sto;ﬁobs Utility Supply Levels

F Active | Completed

Scan and Print Double-sided
Page L of 1

.? Processing job

Status A MName
(Printing Scan and Print Double-sided )

s

2. Select from these options:

» To cancel printing, click the print job and click Delete.

» To pause printing, click the print job and click Hold.

» To resume printing after pausing it, click a print job marked “Hold” and click Resume.

» To check ink status, click Supply Levels.

Note:

You can also cancel printing by pressing your product’s @ stop button.

3. When you’re finished, close the window to exit the program.

If you see an error during printing, see Solve Problems for solutions.
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Scan to Your Computer

You can scan original documents and photos and save them as digital files on your computer.
There are two ways to scan to your computer:
» Scan From the Control Panel

e Scan With Your Computer

Note:
Epson Scan is not available for Mac OS X 10.6. See Scanning With Mac OS X 10.6.

Scan From the Control Panel

You can scan an image to your computer, attach it to an e-mail, or save it as a PDF file. Before
using these features, make sure you’ve installed your product software and connected it to your
computer or network.

Follow the steps in these sections to scan using the control panel:
Scan to PC

Scan to PC (PDF)

Scan to PC (Email)

Your product will automatically select suitable default scan settings. If you want to view or
change those settings, see Change Scan Settings.

Note:

If you are using Mac OS X 10.6 and want to scan from the control panel, your product must be
connected to your computer with a USB cable. Scanning from the control panel produces JPG
files in Mac OS X 10.6.

Change Scan Settings
1. Open Event Manager.

* Windows:
Click € or Start > All Programs or Programs > Epson Software > Event Manager.

e Mac OS X 10.4 and 10.5:
Open the Applications folder, click Epson Software, then click Event Manager.

Click Make Job Settings.

Select the job setting that you want to modify from the Edit Job Settings drop-down list.
Select job settings as necessary.

Click OK when you’re done selecting settings.

o 0o a WP

Click Close to exit the Event Manager settings screen.

Scan to PC
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Scan to PC automatically creates a JPG image and saves it to your computer. This is ideal for
scanning photos, but you can also scan a single-page document this way. (Scan to PC (PDF) is
recommended for scanning documents.)

Before you begin, place your original on the scanner glass.

1. Press the “= menu button.
2. Press A or ¥ to select Scan, then press OK.
3. Press A or ¥ to select Scan to PC, then press OK.

&1.5can to PC
Fress 0K,

4. Do one of the following:

» If your product is connected directly to your computer with a USB cable, press A or ¥ to
select USB Connection, then press OK.

» If your product is connected to a network, press A or ¥ to select your computer name
from the list, then press OK.

Your scanned image file is shown in Windows Explorer or Mac Finder (or as an image capture in
Mac OS X 10.6).

Scan to PC (PDF)

Scan to PC (PDF) automatically creates a PDF file and saves it to your computer. This is ideal for
scanning documents.

Before you begin, place your original on the scanner glass.

1. Press the “= menu button.
2. Press A or ¥ to select Scan, then press OK.
3. Press A or ¥ to select Scan to PC (PDF), then press OK.

&ican to PC (PDF)
Press 3.

4. Do one of the following:

» If your product is connected directly to your computer with a USB cable, press A or ¥ to
select USB Connection, then press OK.

» If your product is connected to a network, press A or ¥ to select your computer name
from the list, then press OK.

Your scanned image file is shown in Windows Explorer or Mac Finder.

Scan to PC (Email)
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Scan to PC (Email) automatically scans a photo or document, launches your e-mail application,
and attaches the file as a JPG image to a new outgoing message. This feature works with MAPI-
type e-mail such as Microsoft® Outlook or Outlook Express, but not web-based e-mail such as
Yahoo® or Gmail. (If you’re not sure, check with your e-mail provider to determine what type of
e-mail account you have. If you have Windows 7, you need to install Outlook or Outlook Express
to be able to use this feature.)

Before you begin, place your original on the scanner glass.

1. Press the “= menu button.
2. Press A or ¥ to select Scan, then press OK.
3. Press A or ¥ to select Scan to PC (Email), then press OK.

23.5can to PC (Eme
Press (3.

4. Do one of the following:

» If your product is connected directly to your computer with a USB cable, press A or ¥ to
select USB Connection, then press OK.

» If your product is connected to a network, press A or ¥ to select your computer name
from the list, then press OK.

5. When scanning is complete, you see this window:

#) Send File Via E-mail =

Eile E-mail Help

Select E-mail Application

= . .
f_]_j |W|ndows Mail

Select Photo Size (JPEG, TIFF anly)
Small (320 x 240 pixels)

Medium (640 x 430 picels)
Large (1280 x 960 pixels)

@ Original

Mumber of Files: |1

Estimated Size: 491 KB
Estimated Time to Send: 7014 zec 56K Modem
0K l | Cancel ‘

Select the e-mail program you use in the Select E-mail Application list.
If you want to resize your image(s), choose an option under Select Photo Size.
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Note:
The box at the bottom of the window displays information about the image file(s) you’re
attaching to the e-mail message.

8. Click OK. Your e-mail program is opened and any scanned images are attached to a new
e-mail message. See your e-mail program for help if you need instructions on sending your
e-mail message.

Scan With Your Computer

You can use your product to scan an image to your computer. Before using this feature, make sure
you’ve installed your product software and connected it to your computer or network.

Note:
Epson Scan is not available for Mac OS X 10.6. For scanning instructions, see Scanning With
Mac OS X 10.6.

Follow the instructions in these sections to scan using Epson Scan:

Start Epson Scan

Select a Scan Mode

Scan in Home Mode (Semi-Automatic)
Scan in Office Mode
Scan in Professional Mode (Fully Manual)

You can also open a TWAIN-compatible scanning program and scan your images directly into the
program window for editing and printing.

Follow the instructions in these sections to perform special scanning tasks:
Restore Color as You Scan

Scan to a PDF File

Choose Scan File Settings

View and Print Scanned Images
Convert a Document to Editable Text (OCR)

Start Epson Scan

Before you start Epson Scan, place your original on the scanner glass or in the Automatic
Document Feeder. Then start Epson Scan in one of the following ways:

e Windows:
Double-click the EPSON Scan icon on your Windows desktop.

e MacOSX:
Open the Applications folder, then the Epson Software folder, and click the EPSON Scan
icon.
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. EPSON Scan = e

Mode:

s
as®  EPSON Scan | Otfice Mods

i |

Image Type

@ Color Grayscale EBlacktwhite
Destination

Document Source: |Aut0 Detect -
Size: Letter(8.5x 11 in] -
Orientation: @ E

Resalution: 300 L. dpi

Image Adjustments
Unsharp Mask Descreening
Image Option
21 Text Enhancement

Auto Area Segmentation

Color Enhance: Fed
Brightnesz: J
Contrast: 0

‘ IJ FPreview ‘ ‘ ﬂ Scan ‘

| Help | | Configuration... | | LCloze

Note:

You can also launch Epson Scan from any TWAIN-compliant application, such as Adobe®

Photoshop®.
Now you can select a scan mode.

Scan From Another Program

Before you start, place your original on the scanner glass or in the Automatic Document Feeder.

1. Start the program you want to use for scanning, and select its scanning option. (See your
scanning program help for instructions.)

Note:

In some programs, you must select your product as the “source” first. If you see a Select
Source option, choose it and select your product.

2. Select your product. Epson Scan starts automatically.

Note:

With Windows, do not choose a WIA option for your product; it will not work correctly.

Now you can select a scan mode.

Select a Scan Mode
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Epson Scan provides a choice of scan modes with different levels of automatic settings. Select the
mode from the Mode box:

[ EPSON Scan (o] -]
e i
kasr  EPSON Scan [Dffice Mode

Image Type
@ Color Grayscale Prafessional Mode
Destination

For instructions on scanning in a mode, click the mode name below:

Home Mode lets you select some settings, and preview and size your scanned image. Color
Restoration, Dust Removal, and Backlight Correction options are available. You cannot scan with
the Automatic Document Feeder in this mode.

Office Mode lets you quickly scan text documents and adjust them on a preview screen. Unsharp
Mask, Text Enhancement, and Descreening options are available. Epson Scan opens in this mode
the first time you use it. You can use the Automatic Document Feeder when scanning in this
mode.

Professional Mode lets you manually customize all available settings, and preview and size your
scanned image. Unsharp Mask, Descreening, Color Restoration, Backlight Correction, Dust
Removal, and Auto Exposure options are available. You can use the Automatic Document Feeder
in this mode.

Scan in Home Mode (Semi-Automatic)
Start Epson Scan and make sure Home Mode is selected as the Mode setting.
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Image Aduslients
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7] Trumbnad
Help '_ Conliguration _' Cloan

Follow the instructions in these sections to select settings as necessary for your type of original:

Select Document or Image Type
Select Scan File Destination

Select Scan Quality (Resolution)

Preview
Select Scanned Image Area

Adjust Image Quality
Select Scanned Image Size

Scan and View Image

Select Document or Image Type
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1. Select the type of original you’re scanning as the Document Type, such as Photograph or
Text/Line Art.

Select whether your original is Color, Grayscale, or Black&White as the Image Type.
Now select the Destination setting.

Select Scan File Destination

Destination

Screensweb @) Printer Other

1. Select the way you plan to use your scanned image as the Destination. The Resolution setting
is selected based on the Destination you choose.

Screen/Web: For images you will e-mail, view on a computer screen, or post on the web.
Printer: For images you will print or documents you are converting to editable text (OCR).
Other: For images that you want to select a custom resolution for.

2. Now you can customize the resolution or preview your image.

Select Scan Quality (Resolution)
Resolution is indicated in dpi (dots per inch).
1. You can enter a custom Resolution only when you choose Other as the Destination setting:
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Destination

Screen/web Printer o Dth,‘?,f

Fezolution: 300 > dpi

2. Select your Resolution based on how and when you will enlarge your image.
Determining a scan resolution

If you plan to enlarge the image so you can print it at a larger size, you may need to increase
the resolution. Follow these guidelines:

* You will enlarge the image as you scan it.
If you will enlarge the images in Epson Scan using the Target Size setting (Home and
Professional modes only) you don’t need to increase the Resolution setting.

* You will scan the image at its original size, but then enlarge it later in an image-
editing program.
If you will enlarge your images later in an image-editing program, you need to increase
the Resolution setting to retain a high image quality. Increase the resolution by the same
amount you will increase the image size. For example, if the resolution is 300 dpi (dots per
inch), and you will increase the image size by 200% later, change the Resolution setting
to 600 dpi.

If you are scanning at 100% or reducing the size, select your Resolution based on how you
will use the scanned image:

E-mail/view on a computer screen/post on the web: 96 to 150 dpi
Print/convert to editable text (OCR): 300 dpi
Fax: 200 dpi
[END DROP DOWN]
3. Now you can preview your image.

Preview
There are two types of preview available:

Thumbnail displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected. If the Thumbnail checkbox is checked, clicking the Preview
button opens a thumbnail preview.

Normal displays your previewed images in their entirety so you can select the scanned image
area and other settings manually. If the Thumbnail checkbox is unchecked, clicking the Preview
button opens a normal preview.

1. Click the Preview button to preview your images in a new Preview window.
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2. To rotate or flip the image (thumbnail preview only), click the thumbnail and click the
IA rotation or 3 mirroring icon.

3. If desired, you can crop the area you want to scan and select image quality settings.

4. When you’re finished, you can select your scan size and scan.

Select Scanned Image Area
In thumbnail preview, your scanned image area is selected automatically.
In normal preview, you create the scanned image area by clicking a button.

You can adjust the scanned image area by creating and/or moving the dotted line (marquee)
outlining the scan area:

1. Do one of the following:

* Thumbnail preview: Create a marquee by placing your cursor in one corner of the
desired scan area, clicking, and dragging the cursor to the opposite corner.
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« Normal preview: Click the & auto locate icon to create a marquee.

Marquee
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To move a marquee, click inside the marquee and drag it where you want it.

To resize a marquee, place the cursor over a marquee edge or corner, then click and drag the
edges where you want them.

Tip:
To retain the marquee width/height proportions, hold the Shift key as you resize the marquee.

4. In Normal Preview mode, you can create up to 50 marquees at a time. Click the .. copy

marquee icon to copy existing marquees, or click the :s delete marquee icon to delete the
selected marquee.

If desired, you can select image quality settings.

When you’re finished, you can select your scan size and scan.

Adjust Image Quality

You can adjust exposure, brightness, and other image quality settings before you scan to improve
your results.
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Image Adjuztments
Descreening
Color Restorgtion
Image Optionf]

Text Enhancement

Auta Area Segrentation

| Brightness...

Backlight Correction
Dzt Remoyal

Setting

Description

Descreening

Removes the rippled pattern that can appear in subtly shaded image areas,
such as in skin tones. Also improves results when scanning magazine or
newspaper images. The results of descreening do not appear in the
preview image, only in your scanned image.

Color Restoration

Restores the colors in faded photos automatically.

Backlight
Correction

Removes shadows from photos that have too much background light.

Dust Removal

Removes dust marks from your originals automatically.

Text Sharpens the appearance of letters in text documents. (Available only

Enhancement when you select Text/Line Art, Newspaper, or Magazine as the
Document Type setting.) Check the Image Option box, then select the
setting.

Auto Area Makes grayscale images clearer and text recognition more accurate by

Segmentation

separating the text from the graphics. (Available only when you select
Text/Line Art, Newspaper, or Magazine as the Document Type setting
and Black&White as the Image Type.) Check the Image Option box,
then select the setting.

Threshold Adjusts the level at which the black areas in text and line art are
delineated, improving text recognition in OCR programs. (Available only
when you select Black&White as the Image Type setting.) Click the
Brightness button to access the setting.

Brightness Adjusts the overall image lightness and darkness.

Contrast Adjusts the difference between the light and dark areas of the overall

image. Click the Brightness button to access the Contrast setting.

Select Scanned Image Size

You can scan images at their original size, or reduce or enlarge them as you scan them. You can
also select a specific scan size (such as 8 x 10 inch [203 x 254 mm] for photos) so you can crop
the image using the correct proportions.
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1. Preview your original image.
2. Select the size you want your scanned image to be from the Target Size list.

Target Size: [5 % Fin "]

Note:
If you need to rotate the orientation of the scan area marquee, click the ‘& orientation icon.

A dotted line (marquee) appears on your preview image proportioned for that size.

i Preaew =y é

Marquee

Help

i0gin Fasdn 1200 1800 pieets 617 ME R84 Ge255 Be2%s

3. If you need to create a scanned image size that is not in the Target Size list, select Customize.
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. Target Size @

Target Size: Target Size M ame:
width:
Height:
Units: in. -
Save Delete
o

4. Name the custom size, enter the size, click Save, and click OK. Then create a marquee on the
preview image to define the scanned image area. The size is automatically proportioned.

5. When you’re finished, you can scan and view your image.

Scan and View Image
After selecting your scan settings, you are ready to scan and view your scanned images.
1. Click Scan.

[ EPSON Scan [ )
r—'j Mode:
j4y" EPSON Scan

Document Type

'pl/ Fhotograph -

Image Type
@ Colar () Grapscale () Black&w/hite
Destination
() Screen®seb @) Printer () Other

300
Target Size: Original ']
Image Adjustments
[ Descreening [ Backlight Correction
[ Color Restoration [ Dust Remaxal

Image Option(]
(@ Text Enhancement
Auto Area Segmentation

Brighthess...
d FBreview Scan '
Thurnbrail d
’ Help ] ’ Configuratian... ] ’ LClose ]
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Note:
If you started your scan from within a TWAIN-compatible scanning program, your scanned
images open in the program window. Click Close to exit Epson Scan.

Select the scan file settings you want to use from the window that appears.
Click OK.
Your scanned image file is shown in Windows Explorer or the Mac Finder.

o M N

Now you can view and print your scanned images, attach them to an e-mail, or use them
however you like.

See also:
Scan in Office Mode
Scan in Professional Mode (Fully Manual)

Scan in Office Mode
Use Office Mode to quickly select settings for scanning text documents.
1. Start Epson Scan and make sure Office Mode is selected as the Mode setting.

- 5
& EPSON Scan [
E 7 Hode:

A EPSON Scan [afice Mode -]
Image Type
@ Color Grayscale EBlacktwhite
Destination
Document Source: |Aut0 Detect - |
Size: Letter(8.5x 11 in] -
Orientation: 8 E‘
Resalution: 300 L. dpi

Image Adjustments
Unsharp Mask Descreening
Image Option
Text Enhancement

Auto Area Segmentation

Calar Enhatce: Fed
Brightness: ] il
Contrast: J i]

‘ IJ Preview ﬂ Scan ‘
| Help | | Configuration... | | LCloze |

2. Select whether your original is Color, Grayscale, or Black&White as the Image Type.

3. Select where you placed your originals as the Document Source setting. Select Auto Detect to
locate the originals automatically, Document Table (for documents placed on the scanner
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glass), or ADF - Single-sided or ADF - Double-sided (for documents placed in the
Automatic Document Feeder).

4. Select the Size of the originals and their Orientation.
5. Select the desired scanning Resolution.
Select a resolution

Resolution is indicated in dpi (dots per inch):

Resolution: 300 dpi

Select your Resolution based on how you will use the scanned image:
E-mail, view on a computer screen, or post on the web: 96 to 150 dpi
Print or convert to editable text (OCR): 300 dpi

Fax: 200 dpi

6. Click the Preview button. Epson Scan previews your document and displays it in the Preview
window.

If you’re using the Automatic Document Feeder, the preview scans the first page and ejects it.
Place the page back on top of the other pages and reload them in the feeder.

7. If desired, you can draw a marguee (or box) around the area you want to scan in the Preview
window.

8. Adjust the image quality, if necessary.
9. Click Scan to scan and view the image.

Your scanned image file is shown in Windows Explorer or Mac Finder.
Now you can view and print the image.

Select Scanned Image Area

You can adjust the scanned image area by creating and/or moving the dotted line (marquee)
outlining the scan area:

1. Click the & auto locate icon to create a marquee.
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2. To move a marquee, click inside the marquee and drag it where you want it.

3. To resize a marquee, place the cursor over a marquee edge or corner, then click and drag the
edges where you want them.
Tip:
To retain the marquee width/height proportions, hold the Shift key as you resize the marquee.

4. You can create up to 50 marquees at a time. Click the = copy marquee icon to copy existing
marquees or click the < delete marquee icon to delete the selected marquee.

Adjust Image Quality

You can adjust exposure, brightness, and other image quality settings before you scan to improve
your results. Before making adjustments, be sure to click the image or marquee for the area you
want to adjust.
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Image Adjustrments
Unsharp Mask
Image Option

Text Enhancement

Calor Enhance:

Auto Area Segmentation

Descreening

Brightness: [} a
Cantrast; {J il
Setting Description

Unsharp Mask

Turn on to make the edges in different areas of your image clearer. Turn
off to leave softer edges.

Descreening

Removes the rippled pattern that can appear in subtly shaded image areas,
such as in skin tones. Also improves results when scanning magazine or
newspaper images. The results of descreening do not appear in the
preview image, only in your scanned image.

Segmentation

Text Adjusts the level at which the black areas in text and line art are

Enhancement delineated, improving text recognition in OCR programs. Check the
Image Option box and then select the setting.

Auto Area Makes grayscale images clearer and text recognition more accurate by

separating the text from the graphics. (Available only when you select
Black&White as the Image Type.) Check the Image Option box and then
select the setting.

Color Enhance

Enhances red, green, or blue shades in the scan. (Available when you
select Grayscale or Black&White for the Image Type setting.) Check the
Image Option box and then select the setting.

Brightness

Adjusts the overall image lightness and darkness.

Contrast

Adjusts the difference between the light and dark areas of the overall
image.

Scan and View Image

After selecting your scan settings, you’re ready to scan and view your scanned images.

1. Click Scan.
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-
& EPSON Scan = ot Z

S 3 Mode:
e EPSON Scan [affics Made -
Image Tupe
@) Color ) Grapscale ) Black&white
Destination
Docurment Sarce: lAuto Detect -
Sige: Letter(25 11 in.) -
Orientation: @ ﬁ
Resolution: 300 - dpi

Image Adjustments
[ Unsharp Mack, [7] Dezoreening
[] Image Option

3 Text Enhancement

Auto Area Segmentation

Color Enhance: Eed
Brightness: [} 0
Contrast; ﬂ 0

‘ \J Preview ‘ Q ﬂ Scan I)
l Help ‘ l Configuration... ‘ l Lloze I
Note:

If you started your scan from within a TWAIN-compatible scanning program, your scanned
images open in the program window. Click Close to exit Epson Scan.

Select the scan file settings you want to use from the window that appears.
Click OK.
Your scanned image file is shown in Windows Explorer or Mac Finder.

SR AN

Now you can view and print your scanned images, attach them to an e-mail, or use them
however you like.

See also:
Scan in Home Mode (Semi-Automatic)

Scan in Professional Mode (Fully Manual)

Scan in Professional Mode (Fully Manual)

Start Epson Scan and make sure Professional Mode is selected as the Mode setting.
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. EPSON Scan

= ? S

b E

kar EPSON Scan  (fp.

de:

Professional Mode -

Settings
Marne:

Original
Document Type:
Document Source:

Auto Exposure Type:

Destination

Image Type:

Resalution:

Document Size:

Current Setting

Delete

Feflective

Document Table

Photo

24-bit Caolor
300 * dpi
W 850 H| 1170 in

Original

Adjustments

Unsharp Mask
[] Descreening
[ Calar Restaration

[ Backlight Correction
[ Dust Removal

d Previen ﬂ Sean
)

[ Thumbnai

LCloze ]

’ Help ] ’ Caonfiguration..

Follow the instructions in these sections to select settings as necessary for your type of original:
Select Document or Image Type
Select Scan File Destination and Scan Quality (Resolution)

Preview
Select Scanned Image Area

Adjust Image Quality
Select Scanned Image Size
Scan and View Image

See also:
Scan in Home Mode (Semi-Automatic)
Scan in Office Mode
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Select Document or Image Type

Original
Document Type:
Document Source:

Auto Exposure Type:

Reflective

Document T able

-

-

| Photo

e |

1. Select the basic type of original you’re scanning as the Document Type. Select Reflective for
documents or photos.

2. Select where you placed your originals as the Document Source setting. Select Document
Table (for documents placed on the scanner glass) or ADF - Single-sided or ADF - Double-
sided (for documents placed in the Automatic Document Feeder).

3. Select the specific type of original as the Auto Exposure Type, such as Document or Photo.
Now select the Destination settings.

Select Scan File Destination and Scan Quality (Resolution)

Destination

Image Type:

24-bit Color

Resolution:

Document Size:

200

W

2.50( H

-

dpi

®

Original

11700 | in.

1. Select the details of your image and how you want to scan it as the Image Type setting.
e 24-bit Color: for color photos
» Color Smoothing: for color graphics, such as charts or graphs
» 8-bit Grayscale: for black-and-white photos
» Black & White: for black text documents or line art

2. Select your Resolution based on how and when you will enlarge your image. Resolution is
indicated in dpi (dots per inch).

If you plan to enlarge the image so you can print it at a larger size, you may need to increase
the resolution. Follow these guidelines:

* You will enlarge the image as you scan it.
If you will enlarge the images in Epson Scan using the Target Size setting (Home and
Professional modes only) you don’t need to increase the Resolution setting.

* You will scan the image at its original size, but then enlarge it later in an image-
editing program.
If you will enlarge your images later in an image-editing program, you need to increase
the Resolution setting to retain a high image quality. Increase the resolution by the same
amount you will increase the image size. For example, if the resolution is 300 dpi (dots per
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inch), and you will increase the image size by 200% later, change the Resolution setting
to 600 dpi.

If you are scanning at 100% or reducing the size, select your Resolution based on how you
will use the scanned image:

E-mail/view on a computer screen/post on the web: 96 to 150 dpi
Print/convert to editable text (OCR): 300 dpi
Fax: 200 dpi

3. Now you can preview your image.

Preview
There are two types of preview available:

Thumbnail displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected. If the Thumbnail checkbox is checked, clicking the Preview
button opens a thumbnail preview.

Normal displays your previewed images in their entirety so you can select the scanned image
area and other settings manually. If the Thumbnail checkbox is unchecked, clicking the Preview
button opens a normal preview.

1. Click the Preview button to preview your images in a new Preview window.

If you’re using the Automatic Document Feeder, the preview scans the first page and ejects it.
Place the page back on top of the other pages and reload them in the feeder.

& Prevew |

Magqess

Hein

SR8 in :r!l M an. I550 x 3908 poosly T 00 ME B G
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To zoom in on your preview image, click the &= auto locate icon and click Zoom.

To rotate or flip the image (thumbnail preview only), click the thumbnail and click the
iA rotation or i mirroring icon.

Now you can select the area you want to scan and select image quality settings.

When you’re finished, you can select your scan size and scan.

Select Scanned Image Area
In thumbnail preview, your scanned image area is selected automatically.
In normal preview, you create the scanned image area by clicking a button.

You can adjust the scanned image area by creating and/or moving the dotted line (marquee)
outlining the scan area:

1. Do one of the following:

* Thumbnail preview: Create a marquee by placing your cursor in one corner of the
desired scan area, clicking, and dragging the cursor to the opposite corner.

& Preaew = y—d

Thurmbrnad | Fod S

Marquee

Hel

320 in. > 358, 960w 1068 preets 293 ME B e B
P

» Normal preview: Click the i* auto locate icon to create a marquee.
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To move a marquee, click inside the marquee and drag it where you want it.

To resize a marquee, place the cursor over a marquee edge or corner, then click and drag the
edges where you want them.

;I)pr.etain the marquee width/height proportions, hold the Shift key as you resize the marquee.

4. Normal preview: You can create up to 50 marquees at a time, click the .; copy marquee icon
to copy existing marquees, or click the =< delete marquee icon to delete the selected marquee.
If desired, you can select image quality settings.

When you’re finished, you can select your scan size and scan.

Adjust Image Quality

You can adjust exposure, brightness, and other image quality settings before you scan to improve
your results. Scroll down to the Adjustments area to view all the options. Click the + icon next to
a setting to change the level of adjustment.
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Adjuztments

[+ [¥] Unsharp Mazk
[+] [] Descreening

Color Restaration

+]

Backlight Carrection

+]

Dust Removal

@ & [ o =

Setting

Description

Unsharp Mask

Turn on to make the edges of image areas clearer for an overall sharper
image. Turn off to leave softer edges.

Descreening

Removes the rippled pattern that can appear in subtly shaded image areas,
such as in skin tones. Also improves results when scanning magazine or
newspaper images. The results of descreening do not appear in the
preview image, only in your scanned image.

Color Restoration

Restores the colors in faded photos automatically.

Backlight
Correction

Removes shadows from photos that have too much background light.

Dust Removal

Removes dust marks from your originals automatically.

Auto Exposure

Click the i@/ auto exposure button. To turn it on continuously, click the
Configuration button, click the Color tab, and select Continuous auto
exposure. You can adjust the level of exposure adjustment using the slider.

Histogram

Provides a graphical interface for adjusting highlight, shadow, and gamma

levels individually. For advanced users only. Click the & histogram
adjustment button to use the settings.

Tone Correction

Provides a graphical interface for adjusting tone levels individually. For

advanced users only. Click the ¥ tone correction button to use the
settings.

Brightness Adjusts the overall image lightness and darkness. Click the = image
adjustment button to access the setting.

Contrast Adjusts the difference between the light and dark areas of the overall
image. Click the = image adjustment button to access the setting.

Saturation

Adjusts the density of colors in the overall image. Click the & image
adjustment button to access the setting.
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Color Balance

Adjusts the balance of red, green, and blue colors in the overall image.
Click the = image adjustment button to access the setting.

Color Palette

Provides a graphical interface for adjusting mid-tone levels, such as skin
tones, without affecting the highlight and shadow areas of the image. For

advanced users only. Click the = color palette button to use the settings.

Threshold

Adjusts the level at which the black areas in text and line art are
delineated, improving text recognition in OCR programs. (Available only
when you select Black & White as the Image Type setting.)

Select Scanned Image Size

You can scan images at their original size, or reduce or enlarge them as you scan them. You can
also select a specific scan size (such as 8 x 10 inch [203 x 254 mm] for photos) so you can crop
the image using the correct proportions.

1. Preview your original image.

2. Select the size you want your scanned image to be from the Target Size list.

|£| Target Size:

ki, §v|

Note:

If you need to rotate the orientation of the scan area marquee, click the & orientation icon.
A dotted line (marguee) appears on your preview image proportioned for that size.

73




Marquee

Help

11in Testin 1200 3 1800 pieels 817 ME B e B

3. If you need to create a scanned image size that is not in the Target Size list, select Customize.

. TargetSize &J
Target Size: Target Size Name:
“fidth:
Height:
Uit in. -
Save Delete
x

4. Name the custom size, enter the size, click Save, and click OK. Then create a marquee on the
preview image to define the scanned image area. The size is automatically proportioned.

5. For additional sizing tools, click the + (Windows) or » (Mac OS X) icon to open the tools.
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(=) Target Size:
' 4.00
Scale:

Trimrming:

4= Ein

S

H B0 in.

1242

2

© Off @ On

@

» Scale: reduces or enlarges your image by the percentage you enter
e Trimming: turns automatic image cropping on or off (see Epson Scan Help for details)

. unlock icon: unlocks the width/height proportions of the scanned image size so you can
adjust it without constraint

6. When you’re finished, you can scan and view your image.

Scan and View Image

After selecting your scan settings, you are ready to scan and view your scanned images.

1. Click Scan.

. EPSON Scan

= |

E:? EPSON Scan

Mode:
Professional Mode -

Settings
Marne:

Original
Document Type:
Document Source:

Auto Exposure Type:

Destination

Image Type:

Resalution:

Document Size:

Adjustments

Current Setting

Save

Feflective

Document Table

Delete

Photo

24-bit Caolor

200 -

dpi

W 850 H| 1170 in

Original

Unsharp Mask
[] Descreening
[ Calar Restaration

[ Backlight Correction

[ Dust Removal

Reset

d Praview ‘ ﬂ Sean l

[ Thumbnai

D ]|

Caonfiguration.. ] ’
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Note:
If you started your scan from within a TWAIN-compatible scanning program, your scanned
images open in the program window. Click Close to exit Epson Scan.

Select the scan file settings you want to use from the window that appears.
Click OK.
Your scanned image file is shown in Windows Explorer or Mac Finder.

Now you can view and print your scanned images, attach them to an e-mail, and use them
however you like.

Restore Color as You Scan

You can restore the colors in faded photos as you scan them using the Color Restoration feature.

1.

2.
3.
4

Place your faded original photo on the scanner glass.

Start the Epson Scan program or open it from another TWAIN-compliant scanning program.

Select the scan mode you want to use.

Follow the instructions in one of these sections for the scan mode you selected:
Home Mode
Professional Mode

Home Mode

1.

SRR I S AN

Select the type of original you’re scanning as the Document Type and Image Type.

Select the way you plan to use your scanned image as the Destination.
Preview your image.
If desired, you can crop the area you want to scan and select your scan size.

Click the Color Restoration checkbox.

Image Adjustments
o] i Backlight Comection

Dust Removal

=]

Text Enhancement

Image O ption

Auto Area Segmentation

Brightness. ..

Note:

You can also select other image quality settings before you scan.

6. Click Scan.

7. Select the scan file settings you want to use from the window that appears.

8. Click OK.

Your color-restored scanned image file is shown in Windows Explorer or Mac Finder.
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Note:
If you started your scan from within a TWAIN-compatible scanning program, your scanned
images open in the program window. Click Close to exit Epson Scan.

Now you can view and print the image.

Professional Mode

1. Select the type of original you’re scanning as the Document Type and Auto Exposure Type.
Select the way you plan to use your scanned image as the Destination.

Preview your image.

If desired, you can crop the area you want to scan and select your scan size.

SR ol R A

Scroll down to the Adjustments area and click the Color Restoration checkbox.

Adjustments

[+] [¥] Unsharp Mask

£ Descreening

+ Backlight Correction

4] [ Dust Remaoval

Note:
You can also select other image quality settings before you scan.

6. Click Scan.

7. Select the scan file settings you want to use from the window that appears.

8. Click OK.

Your color-restored scanned image file is shown in Windows Explorer or Mac Finder.

Note:
If you started your scan from within a TWAIN-compatible scanning program, your scanned
images open in the program window. Click Close to exit Epson Scan.

Now you can view and print the image.

Scan to a PDF File

You can scan a multi-page document and save it in one PDF (Portable Document Format) file on
your computer.

1. Place your original document on the scanner glass or in the Auto Document Feeder.

2. Start Epson Scan.

3. Select a Mode setting.
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. EPSON Scan = ot
r'? Mode:
hra EPSON Scan [foice Mode v]
Image Tupe
@ Colar ) Grayscale () Black&white
Destination
Document Saurce: [Auto Detect -
Sige: Letter8.5 % 11 in.] -
Orientation: ™ E
Resolution: 300 - dpi
Image Adjustments
[ Ungharp Mask, [] Desoreening
[]Image Optian
(@) Text Enhancement
Auto Area Segmentation
Calor Enhance: Eed
Brightness: 0] ]
Contrast; |_| 0
‘ \J Preview ‘ ‘ ﬂ Scan ‘
[ Help ] [ Configuration... ] [ LClaze ]

Select your Document Type and Image Type, then select Destination settings.
Preview your image.
Click Scan.

In the scan file settings window, select a folder for your file and select PDF as the file Type
setting.

Note:
If you don’t see this window, click the 4 File Settings button to open it.

N oo o oA
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8. Click OK.

Your document is scanned and you see this window:

-
Add Page Confirmation

e Scanning complete.

I\ /I Do you want to continue scanning and add more pages?
Select Edit Page to finizh gcanning and edit the pages
before saving the file.

Select Save File to finish scanning and save the file
without editing the pages.
| Add page | [ Edit page ] [ Save File ]

9. If you’re scanning only one page, click Save File.

If you want to scan more pages, click Add Page. Then replace the first page on the scanner
glass with the second page (or add more pages to the Automatic Document Feeder) and click
Scan again, repeating as necessary for each page. When you’re finished, click Save File.

If you want to delete or reorder any of the pages, click Edit Page, then use the icons on the
bottom of the editing window. (Click Help for details.) When you’re finished, click OK.

Note:

If ABBYY® FineReader® is installed, you’ll see the ABBY'Y converting screen. Wait until
the page is re-scanned, then click Close, if necessary.

10. Click Close to exit Epson Scan.
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Now you can view and print the scanned document in Adobe Acrobat® or Reader®, and use it

however you like.

Choose Scan File Settings

Select the location, name, and format of the scanned image file you want to save.

1. Select the folder in which you want to save your scanned image, either My Documents or My
Pictures (some Windows versions), or Documents or Pictures (some Windows versions and

Mac OS X).

If you want to select another folder, click Other, then click Browse (Windows) or Choose
(Mac OS X) and select the folder. To save your image on the desktop, simply click Other.

o File Save Settings
Lo stion
My Docusmenls
& My Pichures
Other

File Hame [Prefoc + 3-digt number]

Ercondreg Slarndad
Emisesd I Profile: 0K

Urwervanlen sy T vl L caime naims
o Showe thia dialog bees helnin nest soan
o Uper enage |okdery alter scannmg
o Chie Bdd Page dalog sfter farning

ok Cancel

Prabe: ng Slarl Humber
Imags Fosmal

Trpe JPEG [ipal -
Drasaili: Comprassion Levek [16G]

)

Heedp:

2. Specify a file name prefix. A 3-digit number is automatically added to the file name, but you
can change the Start Number if you like.

3. Select a file format as described in the following table. Depending on the format, the Options
button may be available for making detailed settings.

Format (File
Extension)

Explanation

BITMAP (*.BMP) | A standard image file format for most Windows programs.

JPEG (*.JPG) The JPEG format lets you highly compress image data. However,
the higher the compression, the lower the image quality. The TIFF
format is recommended when modification and retouching are

required.
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Multi-TIFF (*.TIF) | A TIFF format where multiple pages are saved to the same file and
you can edit the images using a program that supports it.

PDF (*.PDF) A document format that can be read on both Windows and Mac OS
X systems using Adobe Reader or Acrobat. Multi-page documents
can be saved as one PDF file.

PICT (*.PCT) A standard image file format for most Mac OS X programs.

PRINT Image File formats that include Epson PRINT Image Matching® I data for

Matching I (*.JPG | enhanced quality and a wider color range (does not affect the way

or *.TIF) the image displays on the screen).

TIFF (*.TIF) A file format created for exchanging data between many programs,
such as graphic and DTP software.

4. The checkboxes at the bottom of the window give you these options:

» Overwrite any files with the same name
Select to overwrite previous files with the same names.

» Show this dialog box before next scan
Select to have the File Save Settings window appear automatically before you scan.

* Open image folder after scanning
Select to have Windows Explorer or Mac Finder automatically open to the folder where
your scanned image is saved after scanning.

» Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-Tiff format, select to
display a prompt for scanning additional pages after the first page is scanned.

5. Click OK. Epson Scan starts scanning.

View and Print Scanned Images

When you finish scanning images from Epson Scan, you see the scanned file in the Windows
Explorer or Mac Finder window.

Name‘ Date taken Tags

£ EE

img001

Sample Pictures

Size

Follow these instructions to view the image and print it on your product:

1. Double-click the scanned file thumbnail or name.
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The scanned image opens in the program on your computer assigned to the scanned file type,
such as Photo Viewer (Windows) or Preview (Mac OS X) for JPG images, or Acrobat Reader
for PDF images.

Note:
If you want to print from a specific program that supports the file type, you can also open the
program and select the file from a program menu.

Modify the file as necessary in your program.

3. When you’re ready to print, load paper, and follow the instructions in one of these sections:

Windows Printing
Mac Printing (Mac OS X 10.5 and 10.6)
Mac Printing (Mac OS X 10.4)

Note:
Also check the Help utility in your printing program for additional printing instructions.

Convert a Document to Editable Text (OCR)

You can scan a document and convert the image into text that you can edit with a word
processing, spreadsheet, or HTML-editing program. This process is called OCR (Optical
Character Recognition). To scan and use OCR, you need to use an OCR program, such as
ABBYY FineReader.

Windows
Mac OS X 10.4 and 10.5

Windows

1.
2.
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Open the scanner cover and place your original on the scanner glass.

Click & or Start > All Programs or Programs > ABBYY FineReader Sprint > ABBYY
FineReader Sprint.

You see the ABBYY FineReader window:




F
‘b Select New Task l@ _'Eh]

Document Language
English -

' Get Image from Scanner

0 Al
H [ i |
V /= Sean to POF \Zﬁ'ﬁ Scan to Other Formats
\7 I Scan and e-mail images
&7

= Get Image from Folder

r--l ]
’*l — &|| Convert to Other Formats ’*l /= | Conyert to PDF

% ABBYY FineReader Professional Edition Benefits (Learn more...) =

ERd i Ik

ABBYY FineReader Professional Edition provides a large selection of input formats, conversion options, and (=]
saving formats.

Try it now!

3. Select the language of the document you’re going to scan, then click the Scan to Other
Formats icon. You see the Select Scanner window.

4. Select your Epson product, then click OK. The ABBY'Y FineReader scan settings window
opens.

Select your scanning settings.
Click Preview and adjust the area you want to scan, if necessary.
Click Scan. Your document is scanned.

Note:
If you’re scanning multiple pages, select the settings in the Multi-Page Scanning section.
Click the Scan button on the ABBY'Y FineReader window for each page you want to scan.

Click Close after scanning. Your document is processed into editable text.

The Save As window opens. Select a file format for your document (.rtf, .xls, .txt, .htm, and
.pdf), then click the Save button. The file is saved and then opened in the application
associated with the file type you selected.

Mac OS X 10.4 and 10.5

1. Open the scanner cover and place your original on the scanner glass.

2. Open the Applications folder, then click the ABBYY FineReader icon. You see the ABBYY
FineReader window.

3. Select your Epson product in the Get Images From pop-up menu. Then select the language of
your document and the type of document you want to scan.
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Quick Tasks

Y aeevy
FineReader Sprint 8.0

Cet Images From:@PSDN WorkFor... |5 D
Document Language:(English | :D

Convert to Text Document

% Convert to Spreadsheet Document

@ Convert to HTML Document

N /
®

Epson Scan starts in the last mode you used. Select your scanning settings, then click Scan.

5. After your document is scanned, you see the Epson Scan window again. Your document is
scanned and processed into editable text. Close the Preview window, if necessary, then click
the Close button to close Epson Scan.

6. The Save Converted File As window opens. Click the Save button. The file is saved and then
opened in the application associated with the file type you selected.

Save Converted File As

Save As: | FRoutput . E]

Where: | [l Documents | :l

] Open after saving

I:CanceI:] E Save 3

Scanning With Mac OS X 10.6

If you’re using Mac OS X 10.6, follow these steps to scan original documents and photos and
save them as files on your computer:

1. Open an image editing application such as Preview and select Import From Scanner from
the File menu, then select your Epson product.
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If you would like to select scan settings, such as Color Restoration and File Save settings,
click Show Details.

Click the Scan button to begin scanning. Your image is saved to the folder selected in the
Scan To pop-up menu.

Press “Scan” to start

sode: | Fartbed [T

ﬁbqucl: Separate flems
Scan To: | L Pectisres nq

( Show Detaits ) [ Sean
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Replace Ink Cartridges

Your product and its software will let you know when an ink cartridge is low or expended.
If an ink cartridge is expended, you see a message on the LCD screen.

You need to replac
Press OK to replac

Note:
Printing stops when an ink cartridge is expended. If one ink cartridge still contains ink, you may
be able to continue printing temporarily using the remaining cartridge.

When an installed ink cartridge is more than six months old, you may need to replace it if your
printouts do not look their best, even after cleaning and aligning the print head.

Follow the instructions in these sections to check and replace your ink cartridges:
Check Ink Status From the LCD Screen

Check Ink Status From Your Computer

Temporarily Continue Printing When One Ink Cartridge is Expended

Purchase Epson Cartridges

Remove and Install Cartridges

Check Ink Status From the LCD Screen

You can check the ink cartridge status anytime using the LCD screen on your product.

Note:
If an ink cartridge is expended, check the status of the other cartridge using your Windows or Mac
OS X software.

1. Press the v= menu button.

2. Press A or ¥ to select Maintenance, then press OK.
3. Select Ink Levels, then press OK.

21.Ink Levels
Fress OK.

4. The ink cartridge status is displayed. Check the ink levels and replace a cartridge, if necessary.

| LI
BK1 BKZ

5. Press += menu to exit.
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See also:
Check Ink Status From Your Computer

Check Ink Status From Your Computer

You can check the ink cartridge status using your Windows or Mac OS X software. If one of the
screens indicates that a cartridge is expended, replace the cartridge.

Windows
Double-click the %a printer icon in the taskbar, usually in the bottom right corner of your screen.

L1EpsoN Status Monitor 3 : EPSON K300 Series (=5

EPSON "%

Ready to print.,

»

Online Support |

Ink Levels

Black 1 Blads 2
136 136
Infarmation
Frint Queue OK Buy Epson Ink |

Note:

If either of the ink cartridges installed in the printer is broken, incompatible with the printer
model, or improperly installed, Epson Status Monitor will not display an accurate status of the ink
cartridge. Be sure to replace or reinstall the ink cartridge indicated by Epson Status Monitor.

You may also see this screen each time you try to print (if your computer is connected to the
Internet):
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offers.

window.

To enable now, dick Accept,

[¥1Da not display this message again.;

Epson Notification Service : EPSON K300 Series

Epson can notify you of technical updates, promotions, and other

Updates occur when you are connected to the internet. Data to
identify your printer mode! will be sent to Epson. No personally
identifiable information will be sent,

¥ou can enable/disable this feature in the Monitoring Preferences

l

Accept

] ’ Dedine

Select Do not display this message again and click Decline to disable online offers.
Promotional offers are not valid in Latin America.

A Low Ink Reminder window may also appear on your computer screen when you try to print
when ink is low. To disable this window, right-click the a printer icon in the taskbar, usually in
the bottom right corner of your screen, and select Monitoring Preferences. Then uncheck the
Enable Low Ink Reminder checkbox.

You should also uncheck Special Epson Offers in this screen to keep the Special Offers screen

from automatically displaying.

Window.

[~| Display Epson Offers

["]Send Printer Statistics

["]Enable Low Ink Reminder

Monitoring Preferences : EPSOM K300 Series @
Select Notification
Event Screen Notification '
B Error on =
kA Communication Error on
O Ink Low Off
B Maintenance Call on i
Default
Select Shortcut Icon
4 [V]Shortout Toon Example
o > .y
- =i |

Double-dlicking the Shortcut Icon opens the Printer Status

[ Help

Mac OS X

1. Open the Applications folder on your hard drive.




2. Open the Epson Software folder and then Epson Printer Utility 4.
3. Select EPSON Status Monitor.

" n Epeson Printier Utility 4

G

Buy Epiam imk. Dviver Seitiogs

EPSON crson k3o

iU EPSON Starus Monitor

i Lavedy

~ o [

-

— [ [
f ;

InfEFmALon

. Update (- Oy

Note:

The graphic displays the ink cartridge status when Epson Status Monitor was first opened. To
update the ink cartridge status, click Update. If any ink cartridges installed in the printer are
broken, incompatible with the printer model, or improperly installed, Epson Status Monitor will
not display an accurate status of the ink cartridge. Be sure to replace or reinstall any ink cartridge
indicated by Status Monitor.

See also:
Check Ink Status From the LCD Screen

Temporarily Continue Printing When One Ink Cartridge is Expended

When one ink cartridge is expended and one ink cartridge still contains ink, you may be able to
continue printing for a short time on plain paper or envelopes using the remaining cartridge.
However, print speed will be slower, and you should replace the expended ink cartridge as soon as
possible.

Note:
This feature is not available for Mac OS X 10.4.

Follow the instructions in these sections for your operating system:
Windows
Mac OS X 10.5 and 10.6

Windows
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I O

If Epson Status Monitor 3 tells you that one cartridge printing is temporarily available, click
Stop or Cancel Print to cancel your print job.

Note:
If the ink cartridge expended error message originates on another computer on the network,
you may need to cancel the print job at the printer.

Load plain paper or envelopes.

In your print settings, select Plain Papers or Envelope as the paper Type setting.
Select a print quality option.
Print your file.

Epson Status Monitor 3 is displayed on your computer screen again. Click One Cartridge
Print to print with one cartridge.

Mac OS X 10.5 and 10.6

o 0 &~ w

Click your product icon when it appears in the dock at the bottom of the screen.

If you see a message telling you that you can delete the print job and reprint with one ink
cartridge, click the print job, click Delete, and follow the steps below to reprint the document
with one cartridge.

Note:
If the ink cartridge expended error message originates on another computer on the network,
you may need to cancel the print job at the printer.

Open System Preferences, then open the Print & Fax utility.
Make sure your printer is selected, then click on the Options & Supply button.
Click the Driver tab.

Make sure the Permit temporary one cartridge printing check box is selected and then
close the window.

Load plain paper or envelopes.

In your print settings, select Plain Paper or Envelope as the Media Type setting.
Print your file.

Purchase Epson Cartridges

Purchase genuine Epson cartridges and use them within six months of installing them and before
the expiration date on the cartridge box.

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the
nearest reseller, call your nearest Epson sales office. See Getting More Help.
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When you purchase new ink, use the following Epson ink cartridge number:

Ink color Part Number
Black 136
Note:

Leave your old cartridges in your printer until you are ready to replace them to prevent the print
head nozzles from drying out.

We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use,
and temperature. For print quality, a variable amount of ink remains in the cartridge after the
“replace cartridge” indicator comes on. Your printer ships with full cartridges and part of the ink
from the first cartridges is used for priming.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If you bring them inside from out in the cold, allow them
to warm up to room temperature for at least 3 hours before using them.

Remove and Install Cartridges

Be sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Warning:
Keep ink cartridges out of the reach of children and do not drink the ink.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum
packed to maintain reliability.

1. Turn on your product.

2. Ifanink cartridge is low or expended, you see a message on the LCD screen indicating which
cartridge to replace. Press OK.

3. If you’re replacing a cartridge before you see a message on the LCD screen, press “= menu,
press A or ¥ to select Maintenance, and press OK. Then select Ink Cartridge Replacement
and press OK.

4. Open the scanner.
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6. Squeeze the tab on the cartridge and lift it up. Dispose of it carefully. Do not take the used
cartridge apart or try to refill it.

Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your
eyes, flush them immediately with water.

7. Before you open the new cartridge package, shake it four or five times. Then remove it from
the package.

4
z"

8. Remove the yellow tape from the bottom of the ink cartridge.
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Caution:
Do not remove any other labels or seals, or ink will leak. Do not touch the green chip on the
front of the cartridge. This can damage the ink cartridge.

9. Insert the new ink cartridge into the holder and push it down until it clicks into place.
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12. Press OK to begin priming the ink. This takes about 2 1/2 minutes.

When you see a completion message on the LCD screen, ink priming is finished.

Note:
If you see an error message after you have already replaced the ink cartridge, it may not be
installed correctly. Remove and reinstall the ink cartridge so that it clicks into place.

If you replaced a cartridge while copying a document or photo, cancel printing and make sure
your original is still placed correctly on the scanner glass. Then copy your original again.

Caution:
Never turn off your Epson product while ink is priming or you’ll waste ink.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as your product with the label facing upward. Note that there
is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to
prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge
ink supply port or surrounding area, and do not store the cartridge upside down.

If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
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Adjust Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.
Clean the Print Head

Align the Print Head

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

If you see ink on the back of a printout, you may need to clean the paper path.

Clean the Print Head

If your printouts become too light, or you see dark or light bands across them, you may need to
clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note:
You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Follow the instructions in these sections to check your print head nozzles and clean them:
Check the Print Head Nozzles
Clean the Print Head Nozzles

Check the Print Head Nozzles

You can print a nozzle check pattern to check for clogged nozzles using your product’s control
panel or your software. See these sections below:

From the Control Panel

From the Computer

From the Control Panel
Load a few sheets of plain paper in the sheet feeder.

Press = menu.

Press A or ¥ to select Maintenance, then press OK.

Press A or ¥ to select Nozzle Check.

Press the < start button.

Check the nozzle check pattern that prints to see if there are gaps in the lines.

I O o

i

I

/H\H’\’/H\H’\H’

|
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7. If there are no gaps, the print head is clean and you can continue printing.
If there are gaps or the pattern is faint, clean the print head.

From the Computer
1. Load a few sheets of plain paper in the paper cassette.

2. Windows:
Right-click the sz printer icon in the taskbar, usually in the bottom right corner of your screen
(the taskbar) and select Nozzle Check.

Mac OS X:
Open the Applications folder, open the Epson Software folder, and select Epson Printer
Utility 4. Then select Nozzle Check.

o Muzzie Choeck =

1=

To perform & nocde dheck, meke sure that the printer s on and
onnected o the computer, Also make sure that A4 or Lether s plan
e b innded in the paner rassetie. Chok (Print] b eind & nozze
chrth jualber o ek [Canerd] ta gt

Click Print.
Check the printed nozzle check pattern to see if there are gaps in the lines.

il

Nozzles need cleaning Nozzles are clean

5. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Clean the Print Head Nozzles

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean
the print head.
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Note:
You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

You can clean the print head using your product’s control panel or your software. See these
sections below:

Using the Control Panel

From the Computer

Using the Control Panel
1. Load a few sheets of plain paper in the paper cassette.

Press v= menu.
Press A or ¥ to select Maintenance, then press OK.
Press A or ¥ to select Head Cleaning.

o M N

Press the < start button. The cleaning cycle lasts around 2 1/2 minutes.
When you see a completion message on the LCD screen, cleaning is finished.

Caution:
Never turn off your product during a cleaning cycle or you may damage it.

Press ¥ to run a nozzle check to confirm that the print head is clean.
If the printout looks good, press A to finish; if not, press ¥ to run another cleaning cycle.

You may need to clean the print head up to 4 times. You can also turn off your product and
wait at least 6 hours. Then try printing again.

8. When you’re done, press v= menu to exit.

You may need to clean the print head up to 4 times. You can also turn off your product and wait at
least 6 hours. Then try printing again.

Note:

If you do not use your product often, it is a good idea to print a few pages at least once a month to
maintain good print quality.

From the Computer
1. Load a few sheets of plain paper in the paper cassette.

2. Windows:
Right-click the %z printer icon in the taskbar, usually in the bottom right corner of your screen,
and select Head Cleaning.

Mac OS X:
Open the Applications folder, open the Epson Software folder, and select Epson Printer
Utility 4. Then select Head Cleaning.
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3. Follow the on-screen instructions to start the cleaning cycle, which can take up to 2 1/2
minutes.

The & on light flashes throughout the cleaning cycle and stays on green when the cycle is
finished.

Caution:
Never turn off your product during a cleaning cycle or you may damage it.

4. When the O on light stops flashing and remains on, you can check to see if the nozzles are
clean. Click Print Nozzle Check Pattern and click Print.

5. Check the nozzle check pattern that prints to see if there are gaps in the lines.
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Nozzles need cleaning Nozzles are clean

6. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, click Clean to clean the print head again.

You may need to clean the print head up to 4 times. You can also turn off your product and wait at
least 6 hours. Then try printing again.

Note:
If you do not use your product often, it is a good idea to print a few pages at least once a month to
maintain good print quality.

Align the Print Head

If your printouts become grainy or blurry, or you see dark or light bands across them, you may
need to align the print head.
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Note:
Banding may also occur if your print head nozzles need cleaning.

You can align the print head using your product’s control panel or your software. See these
sections below:

Using the Control Panel

From the Computer

Using the Control Panel

1.

o M w N

© o N o

Load a few sheets of plain paper in the paper cassette.

Press v= menu.

Press A or ¥ to select Maintenance, then press OK.

Press A or ¥ to select Head Alignment.

Press the < start button.

The alignment sheet prints.

Look at pattern #1 and find the square patch with no noticeable streaks or lines.
Press A or ¥ to select the number for that patch, then press OK.

Repeat steps 6 and 7 for patterns #2 and #3.

When you finish, you see a message indicating alignment is complete.

10. When you’re done, press = menu to exit.

From the Computer

1.
2.

Load a few sheets of plain paper in the paper cassette.

Windows:
Right-click the s printer icon in the bottom right corner of your screen (the taskbar) and
select Print Head Alignment.

Mac OS X:
Open the Applications folder, open the Epson Software folder, and select Epson Printer
Utility 4. Then select Print Head Alignment.

Follow the on-screen instructions to print an alignment sheet.

Note:
Do not press the @ stop button to cancel printing of the alignment sheet.
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Cancel Hext » |

Check the printed alignment pattern and compare it to the alignment criteria on your screen.
5. Enter the numbers of the best patterns and click Next.

Note:
If no patterns are aligned, choose the closest one and click Realignment. Then print another
alignment sheet and check it.

6. Follow the on-screen instructions to print and compare each alignment sheet, or click Skip.

Clean the Paper Path

If you see ink on the back of a printout, you can clean the paper path and rollers inside the printer.
This removes any excess ink.

1. Make sure there aren’t any originals on the scanner glass.

2. Load several sheets of plain paper.

3. Press the < start button.

4. This feeds paper through the printer to clean the rollers. Repeat if necessary.
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Solve Problems

If you have a problem using your product, check these sections for guidance in diagnosing and
solving the problem:

Checking for Software Updates
Problem-solving Tools

Problems and Solutions

Reinstalling Software

Getting More Help

Note:
If the LCD screen only shows the time, your product is in sleep mode to save power. This occurs
after 13 minutes elapse without pressing a button. Press any button to wake it up.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your product’s
software.

With Windows, you can select Driver Update on the Maintenance tab in the printer settings
window. You can also Click € or Start >, select All Programs or Programs, select EPSON,
select your product, and select Driver Update.

Problem-solving Tools

You can often diagnose problems with your product by checking the messages on the LCD screen.
If the information does not help you solve your problem, check for additional solutions.

To determine if your product is operating properly, run a printer check.

Note:
If you need to reset your product’s default settings, press the = menu button, press A or ¥ to
select Restore Default Settings, and press OK. Press A to confirm your selection.

See also:
ldentify Product Parts

Check LCD Screen Messages

Follow the instructions on the LCD screen to solve most common problems. If you see one of the
error messages below, follow the steps here to proceed.

LCD screen message Problem and solution

You need to replace the following ink Replace the expended cartridges.
cartridge(s): XXX
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LCD screen message

Problem and solution

The ink cartridges are installed incorrectly:
XXX.

Press it down until it clicks into place, then
press OK.

Reinstall the ink cartridge so that it clicks into
place.

Paper out or jam.
Load paper or remove the jammed paper, then
press <.

If paper is out, load paper in the cassette. If
paper is jammed, remove the jammed paper.
Press the ¢ start button.

Paper jam in the ADF.
Remove the jammed paper, and press OK.

Remove the jammed paper from the Automatic
Document Feeder, and then turn your product
off.

Printer error.
See your documentation.

Turn your product off, make sure no paper is
jammed inside, and turn it back on. If the error
is not resolved, contact Epson for help.

Scanner error.
See your documentation.

Turn your product off and then back on. If the
error is not resolved, contact Epson for help.

The printer’s ink pads are nearing the end of
their service life.
Please contact Epson Support.

Contact Epson to replace ink pads before the
end of their service life. When the ink pads are
saturated, your product stops printing and you
need to replace the pads to continue printing.

The printer’s ink pads are at the end of their
service life.
Please contact Epson Support.

Contact Epson to replace ink pads to continue
printing.

Run a Printer Check

A printer check will help you determine if your product is operating properly.
1. If your product is connected to your computer, disconnect the USB or Ethernet cable.

Turn off your product.

Press the () power button to turn on the printer.
Press = menu, press A or ¥ to Select Maintenance, select Nozzle Check, and then press the

2
3. Load plain paper in the paper cassette.
4
5

<& start button.

6. Your product begins printing the nozzle check pattern.

» If the page prints, your product is operating. Your problem may be caused by your
computer, cable, software, or setting selections. Check for additional solutions or reinstall

your software.

If the pattern on the page has gaps, clean or align the print head.
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» If the page does not print, your product may have a problem. Check for additional
solutions. If they don’t work, contact Epson.
Problems and Solutions

Check these sections for solutions to problems you may have using your product:
Setup Problems

Copying Problems

Scanning Problems

Documents Jam in the Automatic Document Feeder
Paper Feeding Problems While Printing

Problems Printing From a Computer

Page Layout and Content Problems

Print Quality Problems (quality is correct on screen)

Image Quality Problems (quality problem appears on screen)

Network Problems

If none of the solutions here solve your problem, contact Epson for help.

See also:
Problem-solving Tools

Reinstalling Software

Setup Problems
Noise After Ink Installation

Software Installation Problems

Control Panel Language Is Incorrect
A Red Light Stays On Inside the Printer After You Turn Off the Power

Noise After Ink Installation

» The first time you install ink cartridges, your product must prime its print head for 2 1/2
minutes. Wait until priming finishes (you see a message that priming is complete) before you
turn off your product, or it may prime improperly and use excess ink the next time you turn it
on.

If your product stops moving or making noise, but the () on light is still flashing after 5
minutes, turn off your product. If the O light is still flashing when you turn it back on, contact

Epson.
» Turn off your product, and then make sure the ink cartridges are inserted completely.

* Make sure no packing materials have been left in your product.

Software Installation Problems
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If you’re installing your product on a network, follow the instructions on the Start Here sheet.

Make sure your product is turned on and the USB or Ethernet cable is securely connected at
both ends. If you still have problems, disconnect the cable and carefully follow the software
installation instructions on the Start Here sheet. Also make sure your system meets the

requirements.

Close your other programs, including any screen savers and virus protection software, and
install the software again.

Make sure your product is selected as the default printer.

If you see an error message or your software doesn’t install correctly in Windows, you may
not have software installation privileges. Contact your System Administrator.

If you connected your product using a USB cable, make sure the USB Controller is working
properly in Device Manager. See your Windows help system for details. If it’s not working,
contact your computer manufacturer. If you are using a USB hub, try connecting your product
directly to your computer.

Control Panel Language Is Incorrect

If you want to use a different language for the messages on the LCD screen:
1. Press the v= menu button, then press A or ¥ to select Maintenance, then press OK.

2. Press A or v, then press » to select your desired language, then press OK.

3. Press the »= menu button to exit.

A Red Light Stays On Inside the Printer After You Turn Off the Power
The light may stay on for up to 15 minutes and then go out automatically. This is normal.

Copying Problems
Nothing Prints, Even Though the On Light Is On

Printing Noise Occurs, Even Though Nothing Prints

Noise Occurs When You Turn on Your product or it Sits for a While

Edges Are Cropped

Photos Are Not Scanned

Nothing Prints, Even Though the On Light Is On

Run a printer check.

If nothing prints when you’re copying, make sure your original is placed face-down on the
scanner glass or face-up in the ADF.

Printing stops when one ink cartridge is expended, although you may be able to continue
printing temporarily with one ink cartridge.

Printing Noise Occurs, Even Though Nothing Prints

Check to see if the print head nozzles are clogged.

107



» Your product won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface
that extends beyond the base in all directions.

Noise Occurs When You Turn on Your product or it Sits for a While

Your product is performing routine maintenance.

Edges Are Cropped

Make sure your original is positioned against the back left corner of the glass. Move your original
away from the edges slightly.

Photos Are Not Scanned

* Make sure they are at least 1.2 x 1.6 inches (3 x 4 cm) in size.

» Place them correctly on the scanner glass.

Scanning Problems

The Scanner Software Does Not Work Properly
You Cannot Start Epson Scan

You Cannot Scan Over Your Network

The Scanner Software Does Not Work Properly

» Make sure your computer has enough memory and meets the other system requirements for
the software you are using. See your software documentation for details.

* The scanner software may not work properly when your computer is in standby mode
(Windows) or sleep mode (Mac OS X 10.4 and 10.5). Restart Epson Scan and try scanning
again.

» The scanner software may not work properly if you upgraded your operating system, but did
not reinstall Epson Scan.

» Ifyou’re using Mac OS X 10.6, you cannot use Epson Scan. Use the ICA scanning application

in Mac OS X 10.6 to scan a document or photo.

You Cannot Start Epson Scan
» Make sure your product is turned on.

» Check the cable connection between your product and your computer to make sure it is
secure.

* The scanner may not work properly when your computer is in standby mode (Windows) or
sleep mode (Mac OS X 10.4 and 10.5). Restart Epson Scan and try scanning again.

* The scanner may not work properly if you upgraded your operating system but did not
reinstall Epson Scan (not available for Mac OS X 10.6).

» Make sure the WorkForce K301 is selected in your scanning program.
* Epson Scan is not available on Mac OS X 10.6. See Scanning With Mac OS X 10.6.
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You Cannot Scan Over Your Network
» Epson Scan is not available on Mac OS X 10.6. See Scanning With Mac OS X 10.6.

» Make sure you’ve restarted your computer after installing the software and setting up the
network connection. The printer cannot detect your computer until you’ve restarted it.

» Make sure Epson Event Manager is not being blocked by your firewall or security software.

» Check to make sure your computer isn’t in standby mode (Windows) or sleep mode (Mac OS
X 10.4 and 10.5).

» If network communication was interrupted while starting Epson Scan, exit Epson Scan, and
restart it after a few seconds. If Epson Scan cannot restart, turn your product off and back on,
and then try restarting Epson Scan. Check the Timeout Setting in Epson Scan Settings. For
details, see the Epson Scan Help.

» Make sure the scanner is selected in the Epson Scan Settings.

Windows:

Click & or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan
Settings. Then select your scanner from the Select Scanner list, select Network as the
Connection setting, and click OK. If you do not see the scanner listed in the Network
Scanner Address window, click Add, let the application search for the scanner or click Enter
address to add the IP address yourself, then click OK.

Mac OS X 10.4 and 10.5:

Double-click the EPSON Scan Settings icon in the Applications > Epson Software folder.
Then select your scanner from the Select Scanner list, select Network as the Connection
setting, and click OK. If you do not see the scanner listed in the Network Scanner Address
window, click Add, let the application search for the scanner or click Enter address to add
the IP address yourself, then click OK.

» If you are scanning a large document at high resolution, a communication error may occur. If
the scan did not complete, lower the resolution.

Documents Jam in the Automatic Document Feeder

If you’re loading legal-size paper, insert only 10 sheets at a time to prevent paper feeding
problems.

If a document jams inside the ADF, follow the steps on the LCD screen to clear the jam. If
necessary, check the following areas:

1. Open the ADF cover and remove any jammed paper.
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Caution:
Do not try to remove the paper without opening the ADF cover first, or you could damage the
mechanism.

2. Leave the ADF cover open, then raise the ADF.

4. Lower the ADF and close the cover.
5. Reload the paper. Make sure the corners of the paper are not bent, folded, or curled up.

Paper Feeding Problems While Printing
Paper Does Not Feed Correctly

Paper Ejects Wrinkled

Paper Jams When Printing

Paper Does Not Feed Correctly

» If paper doesn’t feed, remove it from the paper cassette. Fan the stack and reload it. Make sure
the paper is not above the tabs on the edge guides.

» If multiple pages feed at once, remove the paper from the tray, fan the edges to separate the
sheets, then reload it.

» Make sure you adjust the edge guide to match the length of the paper. Check that the paper is
flush against it before you insert the cassette.
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* Load only up to the recommended number of sheets. If you’re printing on both sides of the
paper, try loading fewer sheets.

» Use new, smooth, high-quality paper, that is not curled, creased, old, or too thin. Make sure to
load it printable side down.

* Do not load paper with holes punched in it for insertion in a binder.

Paper Ejects Wrinkled

» If the paper doesn’t eject fully, you may have set the wrong paper size. Press the <> start
button, then open the scanner and remove the paper. Select the correct paper size when you
reprint.

» If paper is wrinkled when it ejects, the paper may be damp or too thin. Load new paper.

» Make sure the paper Type or Media Type setting matches the paper you loaded.

Paper Jams When Printing

If paper jams when printing, follow the steps on the LCD screen to clear the jam. If necessary,
check the following areas:

1. Lift the scanner and carefully remove any paper trapped inside, including any torn pieces.

Caution:
Be careful not to damage the cables inside the printer. Do not attempt to move the print head
by hand.

2. Lower the scanner and turn your product around.
3. Remove the auto duplexer from the back of your product.
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4. 1f you can see the jammed paper, carefully pull it out. Avoid touching the paper feed rollers.

6. Reattach the auto duplexer.

7. Press the <> start button to clear the error indicator, then press OK.

If paper is still jammed after checking for it in other parts of the printer, follow these steps.
1. Turn your product off, unplug it, and disconnect any cables.

2. Pull out the paper cassette.
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Carefully remove the jammed paper.

Place your product back on its base.
Replace the paper cassette.
Plug in the power cord and USB or Ethernet cable.

© N o 0 &

Turn your product back on.

Problems Printing From a Computer

Nothing Prints, Even Though the On Light Is On
Printing Noise Occurs, Even Though Nothing Prints
Noise Occurs When Your Product Sits for a While
No Printer Icon Appears in Windows Taskbar

Slow Printing
Cannot Print Over a Network

Nothing Prints, Even Though the On Light Is On

» Make sure the USB or Ethernet cable is connected securely at both ends and meets the
requirements.
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* Run a printer check. If the test page prints, make sure your software is installed correctly.

* When one ink cartridge is expended and one ink cartridge still contains ink, you may be able
to continue printing for a short time on plain paper or envelopes using the remaining cartridge.
However, print speed will be slower, and you should replace the expended ink cartridge as
soon as possible.

Printing Noise Occurs, Even Though Nothing Prints
» Check to see if the print head nozzles are clogged.

* Your product won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface
that extends beyond the base in all directions.
Noise Occurs When Your Product Sits for a While

Your product is performing routine maintenance.

No Printer Icon Appears in Windows Taskbar
Try restarting your computer. If you still don’t see the %z printer icon, follow these steps:
1. Do one of the following:

Windows 7:

Click & and select Devices and Printers.

Windows Vista:

Click &, select Control Panel, and click Printer under Hardware and Sound.
Windows XP:

Click Start, select Control Panel, then select Printers and Faxes (or Printers and Other
Hardware and then Printers and Faxes).

Right-click your product and select Printing Preferences.
Click the Maintenance tab.
Click The Monitoring Preferences button.

SR ol N

Click the Shortcut Icon box. Then click OK to close the open windows.

Slow Printing

Make sure your system meets the requirements. If you’re printing a high-resolution image, you
need more than the minimum requirements listed. You may also need to:

» Clear space on your hard drive or run a defragmentation utility.
» Close programs that you’re not using.
* Increase your system’s memory.

» If your printer is connected directly to your computer with a USB cable, use a computer with
a high-speed USB 2.0 port.

» If you installed your product using an Ethernet cable, use a computer and router (or hub or
switch) with 100 Base-T ports.
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» If you print continuously for an extended period, your product may slow down to prevent
overheating. Stop printing for at least 30 minutes, but don’t turn your product off. When you
resume, your product will print at normal speed.

For the fastest printing, try these tips:

* In Windows, make sure the following checkboxes are selected in the Extended Settings
screen: High Speed, Always Spool RAW data, Page Rendering Mode, and Print as
Bitmap.

* For Mac OS X 10.5 and 10.6, enable High Speed Printing. Select System Preferences >
Print & Fax > your product (in the Printers list) > Open Print Queue, then select Driver.

* For Mac OS X 10.4, check the High Speed Printing setting in the Extension Settings pop-up
menu in the Print window of your printer software.

» If your product is connected to a USB hub, disconnect unused USB devices.

Cannot Print Over a Network
» Make sure you set up your software properly for network printing. See the Start Here sheet.

* Try printing to your product from another computer on the network and see if the problem
persists.

Page Layout and Content Problems
Image Is Inverted Like a Mirror Image

Blank Pages Print

Too Many Copies Print

Incorrect Margins

Incorrect Characters Print

Incorrect Image Size or Position

Image Is Inverted Like a Mirror Image
» Turn off the mirror setting in your application program.

Blank Pages Print
* Make sure your product is selected as your printer.
» Check to see if the print head nozzles are clogged.

* In Windows, make sure Skip Blank Page is selected in Extended Settings.

» For Mac OS X 10.5 or later, enable Skip Blank Page. Select System Preference > Print &
Fax > your product (in the Printers list) > Options & Supplies, then select Driver.

Too Many Copies Print

Make sure that the Copies option in your printer software or program is not set for multiple
copies.

Incorrect Margins
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» Make sure the paper settings are correct for your paper size in the Windows, Mac OS X 10.4,
or Mac OS X 10.5/10.6 printer software.

» Choose the correct margins for your paper size in your printing program.

» Use the Print Preview option in your Windows, Mac OS X 10.4, or Mac OS X 10.5/10.6
program to check your margins before you print.

» Make sure your paper is positioned correctly in the cassette.

Incorrect Characters Print

» Make sure the USB or Ethernet cable is securely connected and meets the requirements. Then
try printing again.

» Make sure your printer is selected in Windows.

» Ifyou’re using a switch box or USB hub with your printer, connect the printer directly to your
computer.

» Turn your product off, check that the cables are securely connected, and turn it back on again.

Incorrect Image Size or Position
» If you are scanning, make sure the original is positioned correctly on the scanner glass.

» If you are copying, make sure you selected the correct paper size. See Copy Documents and
Photos for details.

» If you are printing from your computer, make sure the paper and layout options are set
correctly in your Windows, Mac OS X 10.5/10.6, or Mac OS X 10.4 program.

Print Quality Problems (quality is correct on screen)

If your printout has a quality problem but the image looks fine on your computer screen, check the
solutions in this section.

If the image also looks incorrect on screen, check for image quality problems.

Note:
Images will only print in black-and-white.

Printout Has White or Dark Lines Across It
Printout Is Blurry or Smeared

Printout Is Faint or Has Gaps

Printout Is Grainy

Printout Has White or Dark Lines Across It

» The print head nozzles may need cleaning.

» Select a higher Quality option in Windows, Mac OS X 10.5 to 10.6, or Mac OS X 10.4.
* Turn off High Speed mode in the printer software.
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In Windows, disable High Speed Copies. Right-click the % printer icon in the taskbar,
usually in the bottom right corner of your screen, and select Printer Settings. Click the
Maintenance tab, and then click the Extended Settings button.

For Mac OS X 10.5 and 10.6, disable High Speed Printing. Select System Preference >
Print & Fax > your product (in the Printers list) > Options & Supplies, then select Driver.

For Mac OS X 10.4, uncheck the High Speed Printing setting in Extension Settings pop-up
menu in the Print window of your printer software.

» Make sure the paper Type or Media Type setting matches the paper you loaded.
» Make sure the printable side of the paper is face-down. It’s usually brighter or whiter.

* The ink cartridges may need replacing.

» Align the print head.

» The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface
that extends beyond the base in all directions.

Printout Is Blurry or Smeared

» Make sure your paper isn’t damp or curled, or loaded face-up (the printable side should be
face-down).

» Make sure your paper meets the specifications.

» Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
» The print head nozzles may need cleaning.

» Align the print head.

* Remove each sheet from the output tray as it is printed.

* Turn off High Speed mode in the printer software.

In Windows, disable High Speed Copies. Right-click the % printer icon in the taskbar,
usually in the bottom right corner of your screen, and select Printer Settings. Click the
Maintenance tab, and then click the Extended Settings button.

For Mac OS X 10.5 and 10.6, disable High Speed Printing. Select System Preference >
Print & Fax > your product (in the Printers list) > Options & Supplies, then select Driver.

* For Mac OS X 10.4, uncheck the High Speed Printing setting in Extension Settings pop-up
menu in the Print window of your printer software.

» If you are using double-sided paper such as Epson Bright White paper, and you’re printing
heavily saturated or dark images on the front side of the paper, you may notice that smudges
or marks appear on the front when you print the second side. If one side of the paper will
contain a lighter image or text, print that side first to eliminate marks or smudging. If you’re
copying a document or photo, increase the Dry Time.

» Clean the rollers inside your product.

Printout Is Faint or Has Gaps
* The print head nozzles may need cleaning.
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» The ink cartridges may be old or low on ink, and you may need to replace them.
» Make sure the paper Type or Media Type setting matches the paper you loaded.

» Make sure your paper isn’t damaged, old, dirty, or loaded face-up. If it is, reload a new stack
of paper with the printable side down; it is usually brighter or whiter than the other side. For
best results, use genuine Epson paper.

Printout Is Grainy

» Make sure the printable side of the paper is face-down. It’s usually brighter or whiter.

» Select a higher Quality option in Windows, Mac OS X 10.5 to 10.6, or Mac OS X 10.4.

* Turn off High Speed mode in the printer software.

In Windows, disable High Speed Copies. Right-click the & printer icon in the taskbar,
usually in the bottom right corner of your screen, and select Printer Settings. Click the
Maintenance tab, and then click the Extended Settings button.

For Mac OS X 10.5 and 10.6, disable High Speed Printing. Select System Preference >
Print & Fax > your product (in the Printers list) > Options & Supplies, then select Driver.

For Mac OS X 10.4, uncheck the High Speed Printing setting in Extension Settings pop-up
menu in the Print window of your printer software.

» Align the print head.

* You may need to increase the image resolution or print in a smaller size; see your software
documentation.

Image Quality Problems (quality problem appears on screen)

If a scanned image on your computer screen has a quality problem, check the solutions in this
section.

If the image looks correct on screen but prints with poor quality, check for print quality problems.

Note:
The color and quality of images displayed on your product’s screen will not match your originals.

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images

Straight Lines in Image Appear Crooked

Image Is Distorted or Blurry

Image Colors Are Patchy at the Edges

Image Is Too Dark

Back of Original Image Appears in Scanned Image

Ripple Patterns Appear in Image

Image Is Scanned Upside-Down

Scan Area Not Adjustable in Thumbnail Preview

Edges Are Cropped
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Multiple Photos Are Not Scanned

Image Consists of a Few Dots Only

» Make sure the document is placed on the scanner glass with the side to be scanned facing
down.

* When scanning with the Black&White setting in Home, Professional, or Office Mode, adjust
the Threshold setting.

Line of Dots Appears in All Scanned Images

If a dotted line appears in the image, clean the scanner glass with a soft, dry, lint-free cloth (paper
towels are not recommended), or use a small amount of glass cleaner on a soft cloth, if necessary.
Don’t spray glass cleaner directly on the glass.

Straight Lines in Image Appear Crooked
Make sure the document lies perfectly straight on the scanner glass.

Image Is Distorted or Blurry

» Make sure the document lies flat on the scanner glass. Also make sure your document is not
wrinkled or warped.

* Make sure you do not move your document or your product while scanning.

» Make sure your product is placed on a flat, stable surface.

» Select Unsharp Mask in Epson Scan’s Professional Mode.

» Adjust the Auto Exposure setting in Epson Scan’s Professional Mode.

* Increase the Resolution setting in Epson Scan’s Home, Office,or Professional Mode.

Image Colors Are Patchy at the Edges

If your document is very thick or warped at the edges, cover the edges with paper to block
external light as you scan.

Image Is Too Dark

» Adjust the Auto Exposure setting in Epson Scan’s Professional Mode.

» Check the Brightness setting in Epson Scan’s Home, Office, or Professional Mode, or adjust
brightness using the Histogram in Professional Mode (see Epson Scan Help).

» Check the brightness and contrast settings of your computer monitor.

Back of Original Image Appears in Scanned Image

If your original is printed on thin paper, images on the back may be visible to your product and
appear in your scanned image. Try scanning the original with a piece of black paper placed on the
back of it.

Ripple Patterns Appear in Image
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A rippled pattern (called a moiré) may appear in a scanned image of a printed document. It is
caused by interference from the differing pitches in the scanner’s screen and the halftone screen in
your original. To reduce this effect:

» Select the Descreening option in Epson Scan’s Home, Office, or Professional Mode.

» Select a lower Resolution setting in Epson Scan’s Home, Office,or Professional Mode.

Image Is Scanned Upside-Down

In Home or Professional Mode, your product automatically detects the top of certain photos by
analyzing the preview for human faces, the sky, or other orientation factors using Auto Photo
Orientation. It then places the photos in the correct orientation in the scanned file. If your
particular photo is not oriented correctly, you can turn off Auto Photo Orientation and try again.

Click the Configuration button, click the Preview tab, and click the Auto Photo Orientation
checkbox to turn it off.
Scan Area Not Adjustable in Thumbnail Preview

» Create a marquee or adjust the existing marquee to select the area you want to scan in Home
or Professional Mode.

» Switch to the Normal preview (if available) in Home or Professional Mode and preview your
image again.

Edges Are Cropped

Make sure your original is positioned in the front right corner of the glass. Move your original
away from the edges slightly.

Multiple Photos Are Not Scanned

Move your photos further apart, up to 0.8 inch (20 mm).

Network Problems

EpsonNet Setup was Unable to Find My Product on the Network

Your Product Does Not Appear in the Add Printer Window (Mac OS X)
Cannot Print Over the Network

Cannot Find the Scanner or Start Epson Scan
Print a Network Status Sheet

EpsonNet Setup was Unable to Find My Product on the Network
Verify that your product is turned on and connected to your network.

Your Product Does Not Appear in the Add Printer Window (Mac OS X)

Make sure the printer driver was installed correctly and that your computer’s TCP/IP settings are
configured correctly.

Cannot Print Over the Network
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Make sure you set up your software properly for network printing. See the Start Here sheet.
Print a network status sheet and verify that the network settings are correct.

When using TCP/IP, make sure your product’s IP address is set correctly for your network. If
your network does not assign IP addresses using DHCP, you need to set the IP address
manually.

For an Ethernet connection, make sure that your product is turned on, and that your router,
access point, switch, or hub link LED for the port your product is connected to is on or
flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to both your product and your router,
access point, switch, or hub.

» Try connecting to another port on your router, access point, switch, or hub.
» Try connecting your product to another router, access point, switch or hub.

» Try connecting your product to your router, access point, switch, or hub with another
Ethernet cable.

* Try printing from another computer on the network to see if the problem persists.

Cannot Find the Scanner or Start Epson Scan

Epson Scan is not available on Mac OS X 10.6. See Scanning With Mac OS X 10.6.

Make sure you’ve restarted your computer after installing the software and setting up the
network connection. The printer cannot detect your computer until you’ve restarted it.

Make sure Epson Event Manager is not being blocked by your firewall or security software.

Check to make sure your computer isn’t in standby mode (Windows) or sleep mode (Mac OS
X 10.5 or 10.4).

If network communication was interrupted while starting Epson Scan, exit Epson Scan, and
restart it after a few seconds. If Epson Scan cannot restart, turn your product off and back on,
and then try restarting Epson Scan. Check the Timeout Setting in Epson Scan Settings. For
details, see the Epson Scan Help.

Make sure the scanner is selected in the Epson Scan Settings.

Windows:

Click & or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan
Settings. Then select your scanner from the Select Scanner list, select Network as the
Connection setting, and click OK. If you do not see the scanner listed in the Network
Scanner Address window, click Add, let the application search for the scanner or click Enter
address to add the IP address yourself, then click OK.

Mac OS X 10.4 and 10.5:

Double-click the EPSON Scan Settings icon in the Applications > Epson Software folder.
Then select your scanner from the Select Scanner list, select Network as the Connection
setting, and click OK. If you do not see the scanner listed in the Network Scanner Address
window, click Add, let the application search for the scanner or click Enter address to add
the IP address yourself, then click OK.
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» If you are scanning a large document at high resolution, a communication error may occur. If
the scan did not complete, lower the resolution.

Print a Network Status Sheet

1. Press the = menu button.

2. Press A or ¥ to select Network Settings, then press OK.

3. Press A or ¥ to select Network Settings, then select Print Network Status.

4.

Press ¢ start to print the network status sheet.

Reinstalling Software

If you have a problem that requires you to uninstall and reinstall your software, follow the
instructions in one of these sections.

Windows
Mac OS X

Windows
Turn off your product.
Disconnect the USB or Ethernet cable.

1

2

3. Click & or Start, and select All Programs or Programs.

4. Select EPSON, select your product, then select EPSON Printer Software Uninstall.

Note:
If you see a User Account Control window, click Yes or Continue.

Select your product and click OK. Then follow the on-screen instructions.
Open the Windows Control Panel.

In Windows 7 and Windows Vista, select Programs and Features—or, if you’re using
Classic view, select Programs, then click Uninstall a program.

In Windows XP, double-click Add or Remove Programs.

8. Click Epson Event Manager in the list of currently installed programs and click Uninstall/
Change (Windows 7 or Windows Vista) or Change/Remove (Windows XP). Click Yes or
Continue if necessary.

9. Click EPSON Scan in the list of currently installed programs and click Uninstall/Change
(Windows 7 and Windows Vista) or Change/Remove (Windows XP). Click Yes or Continue
if necessary.

10. Click Next.

In some cases, a message may appear to prompt you to restart the computer. If so, make sure
Yes, | want to restart my computer now is selected and click Finish.

11. Restart your computer, then see the Start Here sheet to reinstall your software.
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Mac OS X

Turn off your product.

Disconnect the USB or Ethernet cable.

Insert the printer software CD-ROM in your CD-ROM or DVD drive.

Double-click the Epson CD-ROM icon on your desktop.

Open the Common folder, then open the Epson Scan folder in the CD-ROM window.

o M LD PE

You may have to scroll down to see the Epson Scan folder.
6. Double-click the Epson Scan Uninstaller icon.

When the Installer screen appears, select Uninstall from the pop-up menu at the top and click
the Uninstall button.

7. Follow the on-screen instructions to uninstall Epson Scan.

When Epson Scan uninstall is complete, open the Common folder, then open the Printer
folder in the CD-ROM window.

8. Double-click the EPSON Printer Uninstaller icon.

In the EPSON Printer window, select Uninstall from the pop-up menu at the top and click the
Uninstall button.

9. Follow the on-screen instructions to uninstall the printer software.
10. When the printer driver uninstall is complete, do the following:
e MacOS X104

Open the Applications folder, select Utilities, choose Printer Setup Utility, select
EPSON WorkForce K301, and click Delete.

e Mac OS X 10.50r 10.6
Select System Preferences, select Print & Fax, select your printer, and click the — button.
11. Restart your Mac, and then see the Start Here sheet to reinstall your software.

Getting More Help

If you need additional help with your product or its software, contact Epson. For help with other
software for your product not made by Epson, contact the manufacturer.

Internet Support

Visit Epson’s support website for your product for solutions to common problems. You can
download drivers, get FAQs and troubleshooting advice, or e-mail Epson with your questions (site
available in Spanish and Portuguese only).

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name (WorkForce K301)

* Product serial number (located on the back of product)
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» Proof of purchase (such as a store receipt) and date of purchase
» Computer configuration
» Description of the problem

Then call:
Country Telephone Number
Argentina (54 11) 5167-0300
Chile (56 2) 484-3400
Colombia (57 1) 523-5000
Costa Rica 800-377-6627
Ecuador (593 4) 604-4220
Mexico
Mexico City (52 55) 1323-2052
Other cities 01-800-087-1080
Peru
Lima (51 1) 418-0210
Other cities 0800-10126
Uruguay 00040-5210067
\enezuela (58 212) 240-1111

If your country does not appear on the list, contact the Epson sales office in the nearest country.
Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the
nearest reseller, call your nearest Epson sales office, as described above.

Help With Other Software

Software Online and E-mail
ABBYY FineReader www.abbyyusa.com
support@abbyyusa.com
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Clean and Transport Your Product

If your product gets dirty or you need to move it some distance, follow the instructions in these
sections:

Cleaning
Transportation

Cleaning

To keep your product working at its best, you should clean it several times a year.

Note:
If ink has contaminated the paper feed rollers inside your product (for example, if you see vertical
streaks or smudges on your printouts), you may also need to clean the paper path.

Caution:
Do not use a hard brush, benzine, alcohol, or paint thinner to clean your product or you may
damage it. Do not use oil or other lubricants inside your product or let water get inside it.

1. Turn off your product.

Unplug the power cable.

Disconnect the USB or Ethernet cable.
Remove all the paper.

o M W

Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened
with a little glass cleaner. If necessary, clean the top of the plastic strip (left area outlined
below) with a lint-free cloth only:.
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Caution:
Do not spray glass cleaner directly on the glass and do not press the glass surface with any
force.

6. Clean the LCD screen with a soft, dry cloth. Do not use liquid or chemical cleansers.

7. Open the ADF cover and use a soft, dry, non-abrasive, microfiber cloth to clean the roller and
the interior of the ADF.

8. Close the ADF, then clean the outer case with a soft cloth dampened with mild detergent.

Note:
Close the ADF paper support when you are not using your product to protect it from dust.

Transportation

If you need to ship your product or transport it a long distance, prepare it for transportation as
described below.

Caution:

When storing or transporting your product, avoid tilting it, placing it vertically, or turning it
upside down; otherwise ink may leak.

Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may
prevent your product from printing.

Do not carry your product by the control panel; this may damage your product.

When storing this product in a box, place it so that the control panel does not get damaged.
1. Turn off your product.
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2. Lift up the scanner and check that the print head is all the way to the right (the home position).
If necessary, turn on your product, then turn it off again. Leave the ink cartridges installed.

Lower the scanner.
Remove all the paper from the cassette, and reinsert the cassette.
Unplug all the connected cables.

o 0 &~ w

Close the output tray.

down.
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8. Pack your product in its original box or one of a similar size using protective material to keep
it from moving inside the box.

~gat

9. Keep your product level during transportation to prevent damage.
If print quality has declined when you print again in a new location, clean and align the print head.
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Specifications and Notices

For information about using your product and detailed specifications, see:

Important Safety Instructions

Computer System Requirements

Product Specifications

FCC Compliance Statement

Info-ZIP copyright and license

Open-source Software Notices

Copyright and Trademarks

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions:

Be sure to follow all warnings and instructions marked on your product.
Use only the type of power source indicated on the product label.

Use only the power cord that comes with your product. Use of another cord may cause fires or
shock. Do not use the cord with any other equipment. Make sure the power cord meets all
relevant local safety standards.

Place your product near a wall outlet where the plug can be easily unplugged.

If you won’t be using your product for a long period, unplug the power cord from the
electrical outlet.

Always turn off your product using the () power button, and wait until the () on light stops
flashing before unplugging your product or cutting off power to the electrical outlet.

Avoid plugging your product into an outlet on the same circuit as a photocopier or air
conditioning system that regularly switches on and off, or on an outlet controlled by a wall
switch or timer.

Do not let the power cord become damaged or frayed. Place the cord in a position to avoid
abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not
allow it to be stepped on or run over. Be careful to keep the cord straight at each end. If
damage occurs to the plug, replace the cord or consult a qualified electrician.

If you use an extension cord with your product, make sure the total ampere rating of the
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make
sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall
outlet’s ampere rating.

When connecting the printer to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a
connector in the wrong orientation may damage both devices connected by the cable.

Place your product on a flat, stable surface that extends beyond its base in all directions. It will
not operate properly if it is tilted or at an angle.
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Avoid placing your product in locations that are subject to rapid changes in heat or humidity,
shocks or vibrations, or dust. Do not place your product near a radiator or heating vent or in
direct sunlight. Do not place or store the printer outdoors.

Keep your product away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless phones.

Allow space behind the printer for the cables, and space above the printer so that you can fully
raise the document cover.

Leave enough room around your product for sufficient ventilation. Make sure your product is
at least 4 inches (10 cm) away from the wall.

Do not block or cover openings in your product case or insert objects through the slots.

Do not use aerosol products that contain flammable gases inside or around your product.
Doing so may cause fire.

Do not press too hard on the document table when placing the originals.

Do not open the scanner section while your product is copying, printing, scanning, or faxing.
Be careful not to trap your fingers when closing the scanner cover or scanner.

Do not touch the flat white cable inside your product.

Do not spill liquid on your product. Do not use your product near water. Do not use with wet
hands.

Unplug your product and refer servicing to qualified service personnel under the following
conditions: if the power cord or plug is damaged,; if liquid has entered your product; if your
product has been dropped or the case damaged; if your product does not operate normally or
exhibits a distinct change in performance.

Adjust only those controls that are covered by the operating instructions. Except as
specifically explained in your documentation, do not attempt to service your product yourself.

Never disassemble, modify, or attempt to repair your product by yourself, except as
specifically explained in the documentation. Do not adjust controls that are not covered by the
operating instructions.

When storing or transporting your product, do not tilt it, stand it on its side, or turn it upside
down; otherwise ink may leak from the cartridges.

Always keep this guide handy.

LCD Screen Safety

Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands,
wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes,
flush them immediately with water. If discomfort or vision problems remain after a thorough
flushing, see a doctor immediately.

Ink Cartridge Safety

Keep ink cartridges out of the reach of children and do not drink the ink.
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Shake new ink cartridges four or five times before opening their packages.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink
supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes,
flush them immediately with water. If you still have discomfort or vision problems, see a
doctor immediately.

Do not put your hand inside your product or touch any cartridges during printing.
Do not try to move the print head by hand, or you may damage your product.

Before transporting your product, make sure the print head is in the home (far right) position
and the ink cartridges are in place.

Install a new ink cartridge immediately after removing a used one. Leaving cartridges
uninstalled can dry out the print head and may prevent your product from printing.

Do not dissemble or modify ink cartridges. Doing so may prevent normal printing.
Store ink cartridges in a cool, dark place.

Do not touch the green IC chip on the side of the cartridge. Doing so may prevent normal
operation and printing.

Do not shake ink cartridges after opening their packages, and do not remove the label from the
cartridge itself; this can cause leakage.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as your product. Note that there is a valve in the ink supply
port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining
items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding
area. Do not store cartridges upside down.

mputer System Requirements

To use your product and its software, your computer system should meet these requirements:

Windows Requirements

Microsoft® Windows 7, Windows Vista, Windows XP Professional x64 Edition, or Windows XP
Mac Requirements

Mac OS X 10.4.11, 10.5.8, or 10.6.x

Note:
Visit the Epson website for the latest in compatibility and drivers.

Product Specifications

See

these sections for the detailed specifications of your product:

Printing
Scanning
Automatic Document Feeder (ADF)

Paper
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Ink Cartridges
Size and Weight

Electrical

Environmental
Standards

USB Interface
Network Interface

See also:
Computer System Regquirements

Important Safety Instructions

Printing
Paper path
Front paper cassette, front entry
Capacity
Approx 250 sheets at 20 Ib (75 g/m?)
30 legal-size sheets

Scanning
Scanner type
Flatbed color
Photoelectric device
CIS
Effective pixels
10,200 x 14,040 pixels at 1200 dpi
Document size

Maximum: 8.5 x 11.7 inches (216 x 297 mm) US letter or A4 size
Scanner glass: US letter size or A4
Automatic document feeder: US letter size, legal size (single-sided only), or A4

Scanning resolution

1200 dpi (main scan)
2400 dpi (sub scan)

Output resolution
50 to 4800, 7200, and 9600 dpi (50 to 4800 dpi in 1 dpi increments)
Image data
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16 bits per pixel per color internal
8 bits per pixel external (maximum)

Light source
LED

Automatic Document Feeder (ADF)
Paper input

Face-up loading
Paper output

Face-down ejection
Paper size

US letter size, legal size (single-sided only), or A4
Paper type

Plain paper
Paper weight

17 Ib (64 g/m?) to 24 Ib (95 g/m?)
Sheet feeding capacity

Total thickness of 0.12 inch (3 mm)
Approx. 30 sheets (letter, A4), 10 sheets (legal)

Paper

Use paper under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

gicr:tceé the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always
test a sample of paper stock before purchasing large quantities or printing large jobs.
Single-sheets
Size

A4 (210 x 297 mm; 8.3 x 11.7 inches)

A6 (105 x 148 mm; 4.1 x 5.8 inches)

Letter (8.5 x 11 inches [216 x 279 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)
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Paper types

Plain paper

Special papers distributed by Epson
Thickness (for plain paper)

0.003 to 0.004 inch (0.08 to 0.11 mm)
Weight (for plain paper)

17 Ib (64 g/m?) to 24 1b (90 g/m?)

Envelopes
Size
No. 104 1/8 x 9 1/2 inch (105 x 241 mm)
Paper type
Plain bond paper
Weight
20 Ib (75 g/m?) to 24 1b (90 g/m?)

Printable Area
Note:

When printing borderless, quality may decline in the expanded printable area.

Single sheets

4
Top jﬁ
,% ,,,,,
Left — / '\ Right
.00
Bottom ! - e
Sheets with Borderless
borders printing

Top: 0.12 inch (3 mm) minimum

Left: 0.12 inch (3 mm) minimum

Right: 0.12 inch (3 mm) minimum

Bottom: 0.12 inch (3 mm) minimum
Envelopes
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Bottom Rig‘]ht
Left: 0.12 inch (3 mm) minimum
Bottom: 0.20 inch (5 mm) minimum
Top: 0.20 inch (5 mm) minimum
Right: 0.78 inch (20 mm)

Ink Cartridges

Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use,
and temperature. For print quality, a small amount of ink remains in the cartridge after the
“replace cartridge” indicator comes on.

For best printing results, use up a cartridge within six months of opening the package.
Part numbers and ordering information

Cartridge life

Opened package: within 6 months

Unopened package: do not use if the date on the package has expired
Temperature

Storage: —4 to 104 °F (-20 to 40 °C)

1 month at 104 °F (40 °C)

Ink freezes at 10.4 °F (=12 °C)

Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Size and Weight

Size
Stored:
Width: 17.6 inches (446 mm)
Depth: 14.2 inches (360 mm)
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Height: 9.0 inches (228 mm)
Printing:
Width: 17.6 inches (446 mm)
Depth: 21.9 inches (557 mm)
Height: 9.4 inches (239 mm)
Weight
17.01b (7.7 kg)
(without the ink cartridges or power cable)

Electrical
Power supply rating

100 to 120 V model:
100 to 120 V

220 to 240 V model:
220t0 240V

UPS model:
100 to 240 V

Input voltage range

100 to 120 V model:
90to 132V

220 to 240 V model:
198 to 264 V

UPS model:
90 to 264 V

Rated frequency range
50 to 60 Hz

Input frequency range
49.5t0 60.5 Hz

Rated current

100 to 120 V model:
0.6 A

220 to 240 V model:
03A

UPS model:
06 Ato 0.3 A

Power consumption
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100 to 120 V model:

Printing: Approx. 17 W (ISO/IEC24712 Letter pattern)
Ready mode: Approx. 4.8 W

Sleep mode: Approx. 2.7 W

Power off mode: 0.2 W

220 to 240 V model:

Printing: Approx. 17 W (ISO/IEC24712 Letter pattern)
Ready mode: Approx. 4.8 W

Sleep mode: Approx. 2.8 W

Power off mode: 0.4 W (220 to 240 VV model)

UPS model:

Printing: Approx. 18 W (ISO/IEC24712 Letter pattern)
Ready mode: Approx. 5.5 W

Sleep mode: Approx. 3.2 W

Power off mode: 0.4 W (220 to 240 V model)

Environmental
Temperature
Operation: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (-20 to 40 °C)
1 month at 104 °F (40 °C)
Humidity
Operation: 20 to 80% RH
Storage: 5 to 85% RH
(without condensation)

Standards
Safety
UL60950-1
CAN/CSA C22.2 No. 60950-1
EMC
FCC part 15 Subpart B class B
CAN/CSA-CEI/IEC CISPR 22 Class B

USB Interface
USB
One USB 2.0 Hi-Speed port (Device Class for computers), Type B

Network Interface
Standard
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Ethernet 100BASE-TX/10BASE-T

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio or television reception. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause
interference to radio and television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.
WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the
FCC Certification of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a
shielded equipment interface cable with this device. If this equipment has more than one interface
connector, do not leave cables connected to unused interfaces. Changes or modifications not
expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

Info-ZIP copyright and license

This is version 2007-Mar-4 of the Info-ZIP license. The definitive version of this document
should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely and a copy at
http://www.info-zip.org/pub/infozip/license.html.

Copyright © 1990-2007 Info-ZIP. All rights reserved.

For the purposes of this copyright and license, “Info-ZIP” is defined as the following set of
individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly,
Hunter Goatley, Ed Gordon, lan Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert
Heath, Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden,
Igor Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg
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Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven M. Schweda, Christian
Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White.

This software is provided “as is”, without warranty of any kind, express or implied. In no event
shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or
consequential damages arising out of the use of or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial
applications, and to alter it and redistribute it freely, subject to the above disclaimer and the
following restrictions:

1. Redistributions of source code (in whole or in part) must retain the above copyright notice,
definition, disclaimer, and this list of conditions.

2. Redistributions in binary form (compiled executables and libraries) must reproduce the above
copyright notice, definition, disclaimer, and this list of conditions in documentation and/or other
materials provided with the distribution.

The sole exception to this condition is redistribution of a standard UnZipSFX binary (including
SFXWiz) as part of a self-extracting archive; that is permitted without inclusion of this license, as
long as the normal SFX banner has not been removed from the binary or disabled.

3. Altered versions--including, but not limited to, ports to new operating systems, existing ports
with new graphical interfaces, versions with modified or added functionality, and dynamic,
shared, or static library versions not from Info-ZIP--must be plainly marked as such and must not
be misrepresented as being the original source or, if binaries, compiled from the original source.
Such altered versions also must not be misrepresented as being Info-ZIP releases--including, but
not limited to, labeling of the altered versions with the names “Info-ZIP” (or any variation
thereof, including, but not limited to, different capitalizations), “Pocket UnZip,” “WiZ” or
“MacZip” without the explicit permission of Info-ZIP. Such altered versions are further prohibited
from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or the Info-ZIP URL(S),
such as to imply Info-ZIP will provide support for the altered versions.

4. Info-ZIP retains the right to use the names “Info-ZIP,” “Zip,” “UnZip,” “UnZipSFX,” “WiZ,”
“Pocket UnZip,” “Pocket Zip,” and “MacZip” for its own source and binary releases.

Open-source Software Notices

Open Source Software License
LibTIFF
Open Source Software License

1)This printer product includes open source software programs listed in Section 6) according to
the license terms of each open source software program.

2) We provide the source code of the GPL Programs, LGPL Programs and Apple Public Source
License Programs (each is defined in Section 6) until five (5) years after the discontinuation of
same model of this printer product. If you desire to receive the source code above, please see the
“Contacting Customer Support” in Appendix or Printing Guide of this User's Guide, and contact
the customer support of your region. You shall comply with the license terms of each open source
software program.
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3) The open source software programs are WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
See the license agreements of each open source software program for more details, which are
described in OSS.pdf on your Printer Software CD-ROM.

4) OpenSSL toolkit

This printer product includes software developed by the OpenSSL project for use in the OpenSSL
Toolkit (http://www.openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

5) The license terms of each open source software program are described in OSS.pdf on your
Printer Software CD-ROM.

6) The list of open source software programs which this printer product includes are as follows.
GNU GPL

This printer product includes the open source software programs which apply the GNU
General Public License Version 2 or later version (“GPL Programs”).

The list of GPL Programs:
base-passwd-3.5.7
busybox-1.2.2.1
ifupdown-0.6.8
kernel-2.6.18
Isp-arm-versatile926ejs-2.6.18_pro500
module-init-tools-3.2prel
mount-2.12
net-tools-1.60
netbase-4.29
psmisc-21.5
readline-libs-5.0
sysvinit-2.86
udev-0.093
udhcp 0.9.8cvs20050124-5
util-linux-2.12
ush8786

GNU LGPL

This printer product includes the open source software programs which apply the GNU Lesser
General Public License Version 2 or later version (“LGPL Programs™).

The list of LGPL Programs:
uclibc-0.9.29
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libusb-libs-0.1.12
zeroconf 0.6.1-1
Apple Public Source License

This printer product includes the open source software programs which apply the Apple
Public Source License Versionl.2 or its latest version (“Apple Public Source License
Programs”).

Apple Public Source License Programs:
Bonjour
Net-SNMP license

This printer product includes the open source software program “Net-SNMP”” which applies
the terms and conditions provided by owner of the copyright to the “Net-SNMP”.

OpenSSL License/Original SSLeay License

This printer product includes the open source software program “OpenSSL toolkit” which
applies the license terms of OpenSSL License and Original SSLeay License.

BSD License (Berkeley Software Distribution License)

This printer product includes the open source software programs which apply the Berkeley
Software Distribution License (“BSD Programs™).

The list of BSD Programs:
busybox-1.2.2.1
util-linux-2.12
mount-2.12
mvlutils-2.8.4
netkit-ftp-0.17
netkit-base-0.17
portmap-5beta

Sun RPC License

This printer product includes the open source software programs which apply the Sun RPC
License (“Sun RPC Programs™).

The list of Sun RPC Programs:
busybox- 1.2.2.1
netkit-inetd-0.17
portmap-5beta

TCP Wrappers license

This printer product includes the open source software program “TCP Wrappers” which
applies the terms and conditions provided by owner of the copyright to the “TCP Wrappers”.

“TCP Wrappers” Program:
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libwrap-libs-7.6
libncurses license

This printer product includes the open source software program “libncurses” which applies
the terms and conditions provided by owner of the copyright to the “libncurses.”

“libncurses” Program:
libncurses-5.4
linux-ftpd license

This printer product includes the open source software program “linux-ftpd” which applies
the terms and conditions provided by owner of the copyright to the “linux-ftpd”.

“linux-ftpd” Program:
linux-ftpd-0.17
LibTIFF

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any
purpose is hereby granted without fee, provided that (i) the above copyright notices and this
permission notice appear in all copies of the software and related documentation, and (ii) the
names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity
relating to the software without the specific, prior written permission of Sam Leffler and Silicon
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON
ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE
OR PERFORMANCE OF THIS SOFTWARE.

Copyright and Trademarks

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or
otherwise, without the prior written permission of Seiko Epson Corporation. The information
contained herein is designed only for use with this Epson printer. Epson is not responsible for any
use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product
or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a
result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or
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alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson
Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products
or Epson Approved Products by Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using
any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted
material in certain circumstances, those circumstances may not be as broad as some people
assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark and Epson Exceed Your Vision is a registered logomark of Seiko
Epson Corporation.

Workforce is a registered trademark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.
© 2011 Epson America, Inc.
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